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SOFTWARE LICENSE AGREEMENT

INSTALLING OR OTHERWISE USING THIS SOFTWARE PRODUCT CONSTITUTES YOUR 
ACCEPTANCE OF THE FOLLOWING TERMS AND CONDITIONS (UNLESS A SEPARATE 
LICENSE IS PROVIDED BY THE SUPPLIER OF APPLICABLE SOFTWARE IN WHICH CASE 
SUCH SEPARATE LICENSE SHALL APPLY). IF YOU DO NOT ACCEPT THESE TERMS, YOU 
MAY NOT INSTALL OR USE THIS SOFTWARE, AND YOU MUST PROMPTLY RETURN THE 
SOFTWARE TO THE LOCATION WHERE YOU OBTAINED IT.

THE SOFTWARE INSTALLED ON THIS PRODUCT INCLUDES NUMEROUS INDIVIDUAL 
SOFTWARE COMPONENTS, EACH HAVING ITS OWN APPLICABLE END USER LICENSE 
AGREEMENT (“EULA”). INFORMATION RELATING TO THE EULAS MAY BE FOUND IN AN 
ELECTRONIC FILE INCLUDED ON THE USER DOCUMENTATION CD-ROM INCLUDED 
HEREWITH; HOWEVER, ALL SOFTWARE AND DOCUMENTATION DEVELOPED OR CRE-
ATED BY OR FOR TOSHIBA TEC CORPORATION (“TTEC”) ARE PROPRIETARY PROD-
UCTS OF TTEC AND ARE PROTECTED BY COPYRIGHT LAWS, INTERNATIONAL TREATY 
PROVISIONS, AND OTHER APPLICABLE LAWS.

Grant of License
This is a legal agreement between you, the end-user (“You”), and TTEC and its suppliers. This 
software, fonts (including their typefaces) and related documentation (“Software”) is licensed for 
use with the system CPU on which it was installed (“System”) in accordance with the terms con-
tained in this Agreement. This Software is proprietary to TTEC and/or its suppliers.

TTEC and its suppliers disclaim responsibility for the installation and/or use of this Software, and 
for the results obtained by using this Software. You may use one copy of the Software as 
installed on a single System, and may not copy the Software for any reason except as neces-
sary to use the Software on a single System. Any copies of the Software shall be subject to the 
conditions of this Agreement.

You may not, nor cause or permit any third party to, modify, adapt, merge, translate, reverse 
compile, reverse assemble, or reverse engineer the Software. You may not use the Software, 
except in accordance with this license. No title to the intellectual property in the Software is 
transferred to you and full ownership is retained by TTEC or its suppliers. Source code of the 
Software is not licensed to you. You will be held legally responsible for any copyright infringe-
ment, unauthorized transfer, reproduction or use of the Software or its documentation.

Term
This license is effective until terminated by TTEC or upon your failure to comply with any term of 
this Agreement. Upon termination, you agree to destroy all copies of the Software and its docu-
mentation.

You may terminate this license at any time by destroying the Software and its documentation 
and all copies.

Disclaimer of Warranty
THIS SOFTWARE IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE, AND NON-
INFRINGEMENT. TTEC AND ITS SUPPLIERS DISCLAIM ANY WARRANTY RELATING TO 
THE QUALITY AND PERFORMANCE OF THE SOFTWARE. IF THE SOFTWARE PROVES 
DEFECTIVE, YOU (AND NOT TTEC OR ITS SUPPLIERS) SHALL BE RESPONSIBLE FOR 
THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. TTEC 
AND ITS SUPPLIERS DO NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE 
SOFTWARE WILL MEET YOUR REQUIREMENTS OR THAT THE OPERATION OF THE 
SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE.
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ALL INFORMATION CONTAINED HEREIN THAT IS PROVIDED BY TTEC AND ITS AFFILI-
ATES PURSUANT TO A EULA IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED.

Limitation of Liability
IN NO EVENT WILL TTEC OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY DAMAGES, 
WHETHER IN CONTRACT, TORT, OR OTHERWISE (EXCEPT PERSONAL INJURY OR 
DEATH RESULTING FROM NEGLIGENCE ON THE PART OF TTEC OR ITS SUPPLIERS), 
INCLUDING WITHOUT LIMITATION ANY LOST PROFITS, LOST DATA, LOST SAVINGS OR 
OTHER INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE 
USE OR INABILITY TO USE THE SOFTWARE, EVEN IF TTEC OR ITS SUPPLIERS HAVE 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, NOR FOR THIRD PARTY 
CLAIMS.

U.S. Government Restricted Rights
The Software is provided with RESTRICTED RIGHTS. Use, duplication or disclosure by the 
U.S. Government is subject to restrictions set forth in subdivision (b) (3) (ii) or (c) (i) (ii) of the 
Rights in Technical Data and Computer Software Clause set forth in 252.227-7013, or 52.227-19 
(c) (2) of the DOD FAR, as appropriate. Contractor/Manufacturer is TOSHIBA TEC Corporation, 
6-78, Minami-cho, Mishima-shi, Shizuoka-ken, 411-8520, Japan.

General
You may not sublicense, lease, rent, assign or transfer this license or the Software. Any attempt 
to sublicense, lease, rent, assign or transfer any of the rights, duties or obligations hereunder is 
void. You agree that you do not intend to, and will not ship, transmit (directly or indirectly) the 
Software, including any copies of the Software, or any technical data contained in the Software 
or its media, or any direct product thereof, to any country or destination prohibited by the United 
States Government. This license shall be governed by the laws of Japan or, at the election of a 
Supplier of TTEC concerned with a dispute arising from or relating to this Agreement, the laws of 
the Country designated from time to time by the relevant Supplier of TTEC. If any provision or 
portion of this Agreement shall be found to be illegal, invalid or unenforceable, the remaining 
provisions or portions shall remain in full force and effect.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS LICENSE AGREEMENT AND THAT 
YOU UNDERSTAND ITS PROVISIONS. YOU AGREE TO BE BOUND BY ITS TERMS AND 
CONDITIONS. YOU FURTHER AGREE THAT THIS LICENSE AGREEMENT CONTAINS THE 
COMPLETE AND EXCLUSIVE AGREEMENT BETWEEN YOU AND TTEC AND ITS SUPPLI-
ERS AND SUPERSEDES ANY PROPOSAL OR PRIOR AGREEMENT, ORAL OR WRITTEN, 
OR ANY OTHER COMMUNICATION RELATING TO THE SUBJECT MATTER OF THIS 
LICENSE AGREEMENT.

TOSHIBA TEC Corporation, 6-78, Minami-cho, Mishima-shi, Shizuoka-ken, 411-8520, Japan.
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TRADEMARKS AND COPYRIGHT

Trademarks
The official name of Windows 98 is Microsoft Windows 98 Operating System.
The official name of Windows Me is Microsoft Windows Me Operating System.
The official name of Windows NT is Microsoft Windows NT Operating System.
The official name of Windows 2000 is Microsoft Windows 2000 Operating System.
The official name of Windows XP is Microsoft Windows XP Operating System.
The official name of Windows Vista is Microsoft Windows Vista Operating System.
The official name of Windows Server 2003 is Microsoft Windows Server 2003 Operating 
System.
Microsoft, Windows, Windows NT, and the brand names and product names of other 
Microsoft products are trademarks of Microsoft Corporation in the US and other countries.
Apple, AppleTalk, Macintosh, Mac, TrueType, and LaserWriter are trademarks of Apple Inc. 
in the US and other countries.
PostScript is a trademark of Adobe Systems Incorporated.
Netscape is a trademark of Netscape Communications Corporation.
IBM, AT and AIX are trademarks of International Business Machines Corporation.
NOVELL, NetWare, and NDS are trademarks of Novell, Inc.
TopAccess is a trademark of Toshiba Tec Corporation.
Other company names and product names in this manual are the trademarks of their respec-
tive companies.

Copyright
© 2007  TOSHIBA TEC CORPORATION All rights reserved
Under the copyright laws, this manual cannot be reproduced in any form without prior written 
permission of TTEC. No patent liability is assumed, however, with respect to the use of the infor-
mation contained herein.
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Preface

Thank you for purchasing TOSHIBA Multifunctional Digital Systems or Multifunctional Digital 
Color Systems.  This guide explains how to use TWAIN driver, File Downloader, and e-Filing 
web utility.  Read this guide before using to your Multifunctional Digital Systems or Multifunc-
tional Digital Color Systems. Keep this guide within easy reach, and use it to configure an envi-
ronment that makes best use of the e-STUDIO’s functions.

About This Guide
The guide also provides a detailed explanation of e-Filing features.  Instructions for using e-Fil-
ing web utility to store, edit and manage documents are given.

Conventions
The term “this equipment” in this manual refers to the Multifunctional Digital Systems or Mul-
tifunctional Digital Color Systems.
The term “e-Filing” in this manual is an abbreviation of “electronic filing”.

Lineup of Our Manuals
Thank you for purchasing the TOSHIBA Multifunctional Digital Systems or Multifunctional Digital 
Color Systems.
We have provided you with these manuals for the operation of this equipment. Select and read 
the manual best suited to your needs.

Quick Start Guide
This Quick Start Guide describes the initial setup method of this equip-
ment and accessories of this product such as operator’s manuals and 
CD-ROMs.

Operator’s Manual for Basic Functions
This Operator’s Manual for Basic Functions describes how to use the 
basic functions of this equipment mainly focusing on the copying func-
tion.
Also this manual contains safety precautions for users to be observed. 
Be sure to read it first carefully.

User Functions Guide
This User Functions Guide describes the functions and settings under 
the [USER FUNCTIONS] button on the control panel of this equipment.
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Color Guide (only for the color model)
This color Guide simply explains the functions such as “copy density 
adjustment”, “color adjustment”, “copy editing”, "image editing” and 
“image processing” in color. This guide also includes the basic knowl-
edge of color.

Other guides are provided by the User Documentation CD-ROM in PDF files:
TopAccess Guide
This TopAccess Guide explains how to operate and set up the network 
functions such as the network scanning function and job management, 
using the TopAccess (Web-based utility) from client computers.

Network Administration Guide
This Network Administration Guide explains the guidelines for setting up 
network servers to provide various network services, and troubleshoot-
ing for network administrators.

Printing Guide
This Printing Guide explains how to install the client software for printing 
from Microsoft Windows, Apple Mac OS, and UNIX computers, and print 
to the equipment.

Scanning Guide
This Scanning Guide explains how to operate the scanning function of 
this equipment.
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To read manuals in PDF (Portable Document Format) files
Viewing and printing this operator’s manual in PDF files require that you install Adobe Reader or 
Adobe Acrobat Reader on your PC. If Adobe Reader or Adobe Acrobat Reader is not installed 
on your PC, download and install it from the website of Adobe Systems Incorporated.

e-Filing Guide
This e-Filing Guide explains how to operate the e-Filing function using 
the TWAIN driver, File Downloader and e-Filing web utility.

Network Fax Guide
This Network Fax Guide explains how to use the network fax function 
that enable users to operate fax and internet fax sending from a client 
computer via network.

User Management Guide
This User Management Guide describes how to manage this equipment 
using the functions of “Department Management”, “User Management 
Setting” and “User Authentication for Scan to E-mail”.
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Precautions in this manual
To ensure correct and safe use of this equipment, this operator’s manual describes safety pre-
cautions according to the three levels shown below.
You should fully understand the meaning and importance of these items before reading this 
manual.

Other than the above, this manual also describes information that may be useful for the opera-
tion of this equipment with the following signage:

Indicates a potentially hazardous situation which, if not avoided, could result 
in death, serious injury, or serious damage, or fire in the equipment or sur-
rounding assets.

Indicates a potentially hazardous situation which, if not avoided, may result in 
minor or moderate injury, partial damage of the equipment or surrounding 
assets, or loss of data.

Indicates a procedure you should follow to ensure the optimal performance of 
the equipment and problem-free copying.

Describes handy information that is useful to know when operating the equip-
ment.

Pages describing items related to what you are currently doing. See these 
pages as required.

black and white model e-STUDIO202L/232/282
e-STUDIO203L/233/283
e-STUDIO352/452
e-STUDIO353/453
e-STUDIO520/600/720/850
e-STUDIO523/603/723/853

color model e-STUDIO281c/351c/451c
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Features and Functions

e-Filing web utility is a web-based document editor/organizer for this equipment. It enables you 
to display, edit, merge and store documents on this equipment. For example, you can send two 
documents originating from different applications to e-Filing web utility, merge them into a single 
document, and store it in its repository. You can then print your document using a web browser.
This chapter outlines the tasks involved in setting up, managing and using the application, and 
provides cross-references to detailed information in other chapters.

 P.14 “Organizing Documents”
 P.16 “Using the Systems”
 P.17 “Managing the Systems”
 P.17 “System Requirements”

Organizing Documents
The e-Filing system manages documents with following objects in tree structure.  In the e-Filing 
boxes, up to  10 GB (for the color model) and 5 GB (for the black and white model)  of data can 
be stored.

1) Box
The e-Filing system provides two box types for storing documents, Public and User.  Docu-
ments can be managed using these boxes and they can be handled publicly or confidentially.
- Public — This is a built-in system box to which all users have read and write access. Use 

this box for documents that you wish to share with other users. You cannot change the 
name of this box, but you can create one level of folders within it.

- User — This is a private box that can be managed by each user.  You can create up to 
200 of these boxes and secure them with a password.  If the User Box is protected by a 
password, you must login with the password for that box or login with the system admin-
istrator’s password (only when accessing with e-Filing web utility) to access the User 
Box.  Use this folder for confidential information and for draft documents that you are not 
ready to share.  You can create only one level of folders within each box.

For instructions on how to create user boxes using e-Filing web utility, please refer to the 
following section.

 P.59 “Creating New Boxes”
You can also create user boxes from the Touch Panel Display.  For instructions on how to 
create user boxes from the Touch Panel Display, please refer to the following section.

 P.38 “Creating Boxes”

2) Folders
You can create up to 100 folders in each box, but only one level of folders within each box.  
You cannot create subfolders within folders.

For instructions on how to create user folders, please refer to the following section.
 P.61 “Creating New Folders”
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3) Documents
Documents can be stored directly in a box, and also in a folder in the box.  Up to 400 docu-
ments can be stored in each box and folder.
Documents can be stored in boxes or folders by:
- Copying originals and storing to e-Filing
- Scanning originals and storing to e-Filing
- Printing documents and storing to e-Filing
- Received faxes are routed to store to e-Filing using Mailbox.
- Received faxes/Internet Faxes are forward to store to e-Filing using Fax Received For-

ward and Internet Fax Received Forward (can be registered by an administrator).

Routing the received faxes using a mailbox is available only when the optional Fax unit is 
installed.
Routing the received faxes using the Fax Received Forward is available only when the 
optional Fax unit is installed.
Delete the documents in e-Filing when they are no longer needed.

For instructions on how to store documents in the Boxes and Folders, please refer to the fol-
lowing section.

 P.22 “Storing Documents”

4) Pages
Each document can contain up to 200 pages (for the color model) and 1000 pages (for the 
black and white model).  e-Filing web utility allows you to display the pages in a document.
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Using the Systems
The following figure shows the function diagram of the e-Filing (Please note that it may be 
slightly different depending on the system you are using). 

Control Panel
Storing documents

 P.22 “Storing Scanned Originals Using the Control Panel”
Creating user boxes

 P.38 “Creating Boxes”
Deleting user boxes

 P.41 “Deleting Boxes”
Deleting Folders

 P.43 “Deleting Folders”
Deleting documents

 P.45 “Deleting Documents”
Printing documents

 P.47 “Printing Documents”

Printer Driver
Storing documents

 P.34 “Storing Documents Using the Printer Driver”

TWAIN Driver and File Downloader
Retrieving Documents

 P.150 “Retrieving e-Filing Documents”

e-Filing Web Utility
Creating user boxes

 P.59 “Creating New Boxes”
Deleting user boxes

 P.63 “Deleting Boxes”
Creating folders

 P.61 “Creating New Folders”
Deleting folders

 P.65 “Deleting Folders”
Renaming documents

 P.80 “Renaming Documents”
Deleting documents

 P.82 “Deleting Documents”
Printing documents

 P.84 “Printing Documents”
Archiving documents

 P.90 “Archiving Documents”
Sending documents as Email

 P.98 “Sending Email”
Editing pages in documents

 P.109 “Working with Pages in Your Documents”
Moving or merging documents or pages between boxes, folders, or documents

 P.132 “Moving and Merging Documents”
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Managing the Systems
A system administrator should maintain the data in the e-Filing.  In order to maintain the hard 
disk space for future documents storage, the system administrator can delete documents, fold-
ers, and user boxes that are created or stored by users.

 P.178 “Erasing Box Data”
A system administrator can also maintain the data in the e-Filing using the e-Filing Backup/
Restore Utility.  For more information about e-Filing Backup/Restore Utility, see the following 
section.

 P.180 “Using e-Filing Backup/Restore Utility”

System Requirements
This section describes the system requirements for e-Filing related software.

 P.17 “e-Filing Web Utility”
 P.20 “TWAIN Driver and File Downloader”

e-Filing Web Utility
e-Filing web utility works with the following browsers for Microsoft Windows operating system:

Microsoft Internet Explorer 5.5 Service Pack 2 or later must be installed (for the IPv4 only)
Microsoft Internet Explorer 7.0 or later must be installed (for the IPv6 only)
Netscape Navigator Version 7.2 or later
The minimum display resolution required for these browsers is 800 x 600.
When using the Internet Explorer, the Privacy setting must be set to “Medium” on the 
browser.  Do not set “Block All Cookies” or “High” for the Privacy function.  For instructions 
on how to set the Privacy setting, see the following procedure.
When using the Netscape Navigator, the Cookies setting must be set to “Enable all cookies” 
or “Enable cookies based on privacy settings”.  When the Cookies setting is set to “Enable 
cookies based on privacy settings”, the level of privacy must be set to “medium”.  For instruc-
tions on how to set the Cookies setting, see the following procedure.

How to set the Privacy settings in Internet Explorer

When you are using Internet Explorer, make sure the Privacy setting is set correctly as 
described as following.

1 Run Internet Explorer and select [Internet Options...] in the [Tools] 
menu.

The Internet Options dialog box appears.
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2 Display the Privacy tab and select “Medium” by moving the slider 
and click [OK].

The Privacy setting is saved.

3 Exit the Internet Explorer and run again before accessing e-Filing.

How to set the Cookies settings in Netscape Navigator

When you are using the Netscape Navigator, make sure the Cookies setting is set correctly as 
described as following.
The following procedure describes how to set the Cookies setting in Netscape 7.1.

1 Run Netscape Navigator and select [Preferences] in the [Edit] 
menu.

The Preferences dialog box appears.
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2 Select “Cookies” under “Privacy & Security” in the Category list to 
display the Cookies window, and select “Enable all cookies” or 
“Enable cookies based on privacy settings”.

When you select “Enable all cookies”, go to step 5.
When you select “Enable cookies based on privacy settings”, continue to next step.

3 When you select “Enable cookies based on privacy settings”, click 
[View].

The Privacy Settings dialog box appears.

4 Select “medium” in the Level of Privacy option and click [OK].
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5 Click [OK] to save the settings.

6 Exit the Netscape Navigator and run again before accessing e-Fil-
ing.

TWAIN Driver and File Downloader
The TWAIN driver and File Downloader are available for following environments:

Display Resolution
1024 x 768 dots or more
Display Color
High Color (16bit) or higher is recommended
CPU
Pentium 133 MHz minimum (Pentium 266 MHz or faster recommended)
OS
Windows 98 (Recommended Windows 98 Second Edition)
Windows Me
Windows NT 4.0 Service Pack 6a
Windows 2000 Service Pack 4
Windows XP Service Pack 1/Service Pack 2
Windows Vista
Windows Server 2003 Service Pack 1
Required Software
TWAIN compliant software
Microsoft Internet Explorer 5.5 Service Pack 2 or later must be installed (for the IPv4 only)
Microsoft Internet Explorer 7.0 or later must be installed (for the IPv6 only)
Microsoft Internet Explorer is enabled to access the e-Filing web utility on this equipment.
- The proxy settings must be configured correctly to enable the access.
- The browser must not be offline.

Recommended Memory
For the black and white model: 256 MB
For the color model:
For retrieving A4/LT 600dpi color image / 600dpi black image: 256 MB
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Storing Documents

You can store your documents in the e-Filing as follows:
 P.22 “Storing Scanned Originals Using the Control Panel”
 P.34 “Storing Documents Using the Printer Driver”

Before storing your documents, create user boxes or folders in e-Filing.
 P.37 “Getting Started with Control Panel”
 P.52 “Getting Started with e-Filing Web Utility”

Delete the documents in e-Filing when they are no longer needed.

Storing Scanned Originals Using the Control Panel
You can scan originals and store the scanned document to the e-Filing, using the Control Panel 
of this equipment.  In addition, this equipment supports multi agent operation to store scanned 
documents to the e-Filing.
There are several methods to store originals to e-Filing:

Copying and storing to e-Filing
Scanning to e-Filing
Storing received faxes to e-Filing using a mailbox (Optional Fax unit required)
Storing received faxes to e-Filing using Received Fax Forward (Optional Fax unit required)
Storing received Internet Faxes to e-Filing using Received Internet Fax Forward

A document that is stored by “Copying and storing to e-Filing” is proper for output, and not for 
importing as an image into your computer.  To get the best image quality for importing an image 
into your computer, please store the document by “Scanning to e-Filing”.

Registering a mailbox can be performed from the Touch Panel Display or TopAccess.  For 
instructions on how to register a mailbox, please see the Operator’s Manual for Facsimile 
Function or TopAccess Guide.
Registering Received Fax Forward or Received Internet Fax Forward can be performed from 
TopAccess by an administrator.  For instructions on how to register the Received Fax For-
ward or Received Internet Fax Forward, please see the TopAccess Guide.

Copy and Store to e-Filing
This equipment allows you to store originals as e-Filing documents as well as copying them.  
The originals will be stored in the e-Filing box as the copy settings are applied.

Copying and Storing to e-Filing

1 Place the original(s).
For instruction about placing the originals, see Operator’s Manual for Basic Func-
tions.

2 Press the [E-FILING/FILE] button on the basic screen to enter the 
filing menu.
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3 Press the [STORE TO E-FILING] button.

The STORE TO E-FILING screen is displayed.

4 Press the [BOX/FOLDER] button.

The box list screen is displayed.

5 Select the box in which you want to store the data and press the 
[ENTER] button.

Select either the “Public Box” button or desired user box button.
If the user box that you want to store the data is not shown in the list, press the [Next] 
or [Prev] buttons to change the list on the screen.

If the user box that you want to store the data has not been registered, you must register 
the user box first.
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6 If you select a user box that a password is set, the password entry 
screen may be displayed.  If the password entry screen is dis-
played, enter the password using the digital keys and press the 
[ENTER] button.

The list of the documents and folders for the selected box is displayed.

7 When you want to store the original(s) in an existing folder, select 
the folder and press the [OPEN FOLDER] button to display the list 
in the folder, and then press the [ENTER] button.
If you want to store the original(s) in the selected box, press the 
[ENTER] button.

The screen returns to the SCAN TO E-FILING screen.

8 Press the [DOCUMENT NAME] button if you want rename the docu-
ment name of the scanned data.

The letter entry screen is displayed.  Enter the value using the keyboard and digital 
keys, and press the [ENTER] button to set the entry.

9 Press the [ENTER] button.
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10 When “PRINT THIS DOCUMENT?” message is displayed, press the 
[YES] button to store and print the document.

If you want to store the document without printing, press the [NO] button.

11 Press the [START] button.

12 If the “NEXT ORIGINAL?” message is displayed, place another orig-
inal on glass and press the [YES] button to copy another original, 
or press the [FINISHED] button to finish copying.

When the original is set on the Automatic Document Feeder, this screen is not dis-
played.
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Scan to e-Filing
When you want to store the document in e-Filing to retrieve scanned images into your computer, 
it is recommended to store the document using Scan to e-Filing rather than Copy and Stored to 
e-Filing.

Scanning Procedure for Scan to e-Filing

1 Place the original(s).
For instruction about placing the originals, see Operator’s Manual for Basic Func-
tions.

2 Press the [SCAN] button on the control panel to enter the scan 
menu 
Please note that the location of the button may be different depend-
ing on the system you are using.

The basic scan menu is displayed.

3 Press the [SCAN TO E-FILING] button.

The SCAN TO E-FILING screen is displayed.

For the black and white model, the Scan to e-Filing operation is available only when the Scanner Kit is 
installed, or when the Printer/Scanner Kit is installed.
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4 Press the [BOX/FOLDER] button.

The box list screen is displayed.

5 Select the box in which you want to store the data and press the 
[ENTER] button.

Select either the “Public Box” button or desired user box button.
If the user box that you want to store the data is not shown in the list, press the [Next] 
or [Prev] buttons to change the list on the screen.  You can also select the user box 
by entering the box number using the digital key.

If the user box that you want to store the data has not been registered, you must register 
the user box first.  For setting up the user boxes, see e-Filing Guide.  (The instruction on 
how to set up the user boxes using the touch panel also describes in Operator’s Manual 
for Basic Functions.)

6 If you select a user box that a password is set, the password entry 
screen may be displayed.  If the password entry screen is dis-
played, enter the password using the digital keys and press the 
[ENTER] button.

The list of the documents and folders for the selected box is displayed.
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7 When you want to store the original(s) in an existing folder, select 
the folder and press the [OPEN FOLDER] button to display the list 
in the folder, and then press the [ENTER] button.
If you want to store the original(s) in the selected box, press the 
[ENTER] button.

The screen returns to the SCAN TO E-FILING screen.

8 Press the [DOCUMENT NAME] button if you want rename the docu-
ment name of the scanned data.

The letter entry screen is displayed.  Enter the value using the keyboard and digital 
keys, and press the [ENTER] button to set the entry.

9 Press the [EDIT] button to set the scanning conditions.
The screen to set the scan conditions is displayed.
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10 Specify the following items as you require, and press the [Next] 
button (Please note that the location of the button may be different 
depending on the system you are using).
e-STUDIO352/452, e-STUDIO353/453, e-STUDIO202L/232/282 and e-STUDIO203L/
233/283:

e-STUDIO281c/351c/451c:

e-STUDIO520/600/720/850 and e-STUDIO523/603/723/853:

SINGLE/2-SIDED SCAN
[SINGLE] — Press this when scanning only the front page of originals.
[BOOK] — Press this when scanning both side of originals in the same direction.
[TABLET] — Press this when scanning front page in the general direction, and scanning 
back page rotated 180 degree.
ROTATION
[0 degree] — Press this not to rotate the scanned image.
[90 degree right] — Press this to rotate the scanned image 90 degree on the right.
[180 degree] — Press this to rotate the scanned image 180 degree.
[90 degree left] — Press this to rotate the scanned image 90 degrees on the left.
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COLOR MODE*1
Select the button of the color mode for scanning.

The “ORIGINAL MODE” option cannot be set when [GRAY SCALE] is selected in the 
“COLOR MODE” option.

ORIGINAL MODE
[TEXT] — Press this when scanning the originals that contain texts.
[TEXT/PHOTO] — Press this when scanning originals that contain texts and photos.
[PHOTO] — Press this when scanning originals that contain photos printed on 
photographic paper.
[PRTD IMAGE]*1 — Press this when scanning originals as printed images.  This can be 
set only when [FULL COLOR] or [AUTO COLOR] is selected in the “COLOR MODE” 
option.
[GRAY SCALE]*2 — Press this when scanning originals as gray scale pictures.
*1 Only applicable to the color model.
*2 Only applicable to the e-STUDIO520/600/720/850 and e-STUDIO523/603/723/853.

RESOLUTION
[600] — Press this when scanning originals in 600 dpi.  For the color model, this can be 
set only when [BLACK] is selected in the “COLOR MODE” option.  When the optional 
expansion memory is installed, this can be set even if other than [BLACK] is selected in 
the “COLOR MODE” option.
[400] — Press this when scanning originals in 400 dpi.
[300] — Press this when scanning originals in 300 dpi.
[200] — Press this when scanning originals in 200 dpi.
[150] — Press this when scanning originals in 150 dpi.
[100]* — Press this when scanning originals in 100 dpi.  This cannot be set when 
[BLACK] is selected in the “COLOR MODE” option.
* Only applicable to the color model.
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11 Specify the following items as you require, and press the [Next] 
button for the e-STUDIO520/600/720/850, e-STUDIO523/603/723/853 
and the [Enter] button for the e-STUDIO281c/351c/451c, e-
STUDIO352/452, e-STUDIO353/453, e-STUDIO202L/232/282 and e-
STUDIO203L/233/283 (Please note that the location of the button 
may be different depending on the system you are using).
e-STUDIO352/452, e-STUDIO353/453, e-STUDIO202L/232/282 and e-STUDIO203L/
233/283:

e-STUDIO281c/351c/451c, e-STUDIO520/600/720/850 and e-STUDIO523/603/723/853:

ORIGINAL SIZE
Select the button of the original size, or select the [AUTO] button to automatically detects 
the original size.
When placing the different size originals on the Automatic Document Feeder, select the 
[MIXED ORIGINAL SIZE] button.
EXPOSURE
Press light or dark buttons to specify the exposure for scanning manually, or press the 
[AUTO] button to select auto mode for the exposure mode for scanning.  For the color 
model, this can be set only when the [BLACK] button is selected at the “COLOR MODE” 
option.  When other than the [BLACK] button is selected at the “COLOR MODE” option, 
the setting will be changed to “BACKGROUND ADJUSTMENT”.
BACKGROUND ADJUSTMENT*
Press light or dark buttons to specify the background for scanning manually.  This can be 
set only when other than the [BLACK] button is selected at the “COLOR MODE” option.  
When the [BLACK] button is selected at the “COLOR MODE” option, the setting will be 
changed to “EXPOSURE”.
* Only applicable to the color model.
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JPEG COMPRESS (only for the e-STUDIO281c/351c/451c, e-STUDIO520/600/720/
850 and e-STUDIO523/603/723/853)
Select the JPEG compression for scan data.  For the e-STUDIO281c/351c/451c, this 
cannot be set when the [BLACK] button is selected at the “COLOR MODE” option.  For 
the e-STUDIO520/600/720/850 and e-STUDIO523/603/723/853, this can be set only 
when the [GRAY SCALE] button is selected at the ORIGINAL MODE option.

12 Specify the following items as you require, and press the [Enter] 
button.*

BACKGROUND ADJUSTMENT
Press light or dark buttons to specify the background for scanning manually.
SHARPNESS
Press light or dark buttons to specify the sharpness for scanning manually.
* Only applicable to the e-STUDIO520/600/720/850 and e-STUDIO523/603/723/853.

13 Press the [ENTER] button.

The screen returns to the basic scan menu.



Storing Documents    33

14 Press the [SCAN!] button.

You can also set another scan agent, by pressing either the [SCAN TO FILE ] button or 
[SCAN TO E-MAIL] button to set the scanning conditions.

15 If the “To continue, place document on glass.  And press Scan!” 
message is displayed, place another original on glass and press 
[SCAN!] to scan another original, or press the [JOB FINISH] button 
to finish scanning.

When the original is set on the Automatic Document Feeder, this screen is not dis-
played.  However, this screen is displayed when you press the [CONTINUE] button 
during scanning the originals.
If you want to cancel the storage of the scanned data, press the [JOB CANCEL] but-
ton.
You can change the setting of the original type and scanning conditions, using the 
[EDIT] button before pressing the [SCAN!] button.



2 Getting Started

34    Storing Documents

Storing Documents Using the Printer Driver
From an application that runs under a Windows operating system, you can send a document as 
a print job to the e-Filing with the printer driver.
You can save a print job to either public box or user box.  Because the public box is shared by all 
users, all users can see the jobs saved in this box.  User box can be used for personal uses and 
it can protected by password.

When you store a document in e-Filing using the printer driver, the printing image (not the origi-
nal document in your computer) will be stored in e-Filing.

For more information about the printer driver, please refer to Printing Guide.

Saving a print job to a public box

1 Open the document that you want to store in the box.

2 Click the [File] menu and select [Print] in your application.
The Print dialog box appears.

3 Select the printer driver of the equipment to be used and click 
[Properties].

The printer properties dialog box appears.

The procedures for displaying the properties dialog for the printer driver may be different 
depending on an application that you are using. See your applications manual about dis-
playing the printer properties dialog box.

4 Select “Store to e-Filing” in the “Print Job” drop down box.

5 Click [...].
The Password dialog box appears.



Storing Documents    35

6 Select “Public Box” to save a print job to a public box.

7 If you print a job as well as saving it to a box, check the “Print” box.

8 Click [OK].

9 Set other print options you require and click [OK].

10 Click [OK] to send a print job.
The print job is saved to a public box.

Saving a print job to a user box

1 Open the document that you want to store in the box.

2 Click the [File] menu and select [Print] in your application.
The Print dialog box appears.

3 Select the printer driver of the equipment to be used and click 
[Properties].

The printer properties dialog box appears.

The procedures for displaying the properties dialog for the printer driver may be different 
depending on an application that you are using. See your applications manual about dis-
playing the printer properties dialog box.

4 Display the Print Job tab and select “Store to e-Filing”.

5 Click [...].
The Password dialog box appears.
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6 Select user box number to be save.

If the “Enable SNMP Communication” is enabled on the Configuration tab, only the user 
boxes that have been set up will be displayed in the drop down box.

7 Enter the password for the user box in the “Password” field.

8 If you print a job as well as saving it to a box, check the “Print” box.

9 Click [OK].

10 Set other print options you require and click [OK].

11 Click [Print] to send a print job.
The print job is saved to a specified user box.
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Getting Started with Control Panel

This section describes how to manage the e-Filing functions using the Control Panel on this 
equipment.

Users can perform the following e-Filing operations using the Control Panel:
Creating and managing boxes

 P.38 “Creating Boxes”
 P.40 “Editing Boxes”
 P.41 “Deleting Boxes”
 P.43 “Deleting Folders”

Managing documents
 P.45 “Deleting Documents”
 P.47 “Printing Documents”

Creating and Managing Boxes
e-Filing web utility provides two box types: Public box and User box.

Public Box
All users can access the main Public box to create, edit, move and delete public documents 
and folders. Use the Public box to store documents that any user may need to work with.
User Box
Each user can create his own user box or a user box that can be shared with other, specific 
members.  The user box also can be protected by a password.  Users can then store, dis-
play, edit and print confidential documents — which can be their own or others.  To access 
the password-protected user box, users must enter the password for the box.

Before storing documents in the e-Filing, prepare the boxes to manage documents efficiently.

Users cannot create folders in boxes using the Control Panel.  Folders can be created using e-
Filing web utility.

 P.59 “Creating Boxes and Folders”
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Creating Boxes
Users can create up to 200 user boxes and protect each box with a password.

Users can also create user boxes from the e-Filing web utility.  For instructions on how to create 
user boxes from the e-Filing web utility, please refer to the following section.

 P.59 “Creating New Boxes”

Creating a user box

1 Press the [e-FILING] button on the control panel 
Please note that the location of the button may be different depend-
ing on the system you are using.

2 Select a blank button numbered from 001 to 200, and then press the 
[SETUP] button.
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3 Press the [BOX NAME] button.

The letter entry screen is displayed.

4 Enter the box name using the keyboard and digital keys, and press 
the [ENTER] button to set the entry.

Box names consist of any ASCII characters except: \ / < > " % & = ' ; : * ? | # [ ] { }. Do 
not use a space or period at the beginning or end of the name. The maximum size of 
a box name is 32 characters.

5 If you want to protect the user box with a password, enter the 5-
digit password in the “Password” and “Retype Password” fields.

To set a password, press the “Password” field, enter the 5-digit password using the 
digital keys, and press the [SET] button to set the entry.  After pressing the [SET] but-
ton, the “Retype Password” field will be highlighted and then enter the same pass-
word.

6 Press the [ENTER] button.
The user box is created.
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Editing Boxes
The registered user box name and password can be changed.

Editing a user box

1 Press the [e-FILING] button on the control panel 
Please note that the location of the button may be different depend-
ing on the system you are using.

2 Select a user box button that you want to edit, and then press the 
[EDIT] button.

When the password has been set to the selected user box, the password entry 
screen is displayed.  In that case, continue to next step.
When the password had not been set to the selected user box, skip to Step 4.

3 If the password entry screen is displayed, enter the 5-digit pass-
word using digital keys and press the [ENTER] button.



Getting Started with Control Panel    41

4 Change the user box name and password as you require and press 
the [ENTER] button.

The user box settings has been modified.

Deleting Boxes
Users can delete the user box.  

Once the user box is deleted, all folders and documents in the deleted user box will be deleted.

Deleting a user box

1 Press the [e-FILING] button on the control panel .
Please note that the location of the button may be different depend-
ing on the system you are using.
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2 Select a user box button that you want to delete, and then press the 
[DELETE] button.

When the password has been set to the selected user box, the password entry 
screen is displayed.  In that case, continue to next step.
When the password had not been set to the selected user box, skip to Step 4.

3 If the password entry screen is displayed, enter the 5-digit pass-
word using digital keys and press the [ENTER] button.

4 Press the [YES] button to delete the selected user box.

The user box is deleted.
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Deleting Folders
Users can delete a folder from the Control Panel.

Users cannot create a folder from the Control Panel.  Users can create a folder using the e-
Filing web utility.

 P.61 “Creating New Folders”
Once the folder is deleted, all documents in the deleted folder will be deleted.

Deleting a folder

1 Press the [e-FILING] button on the control panel.
Please note that the location of the button may be different depend-
ing on the system you are using.

2 Select a box button that contains a folder you want to delete, and 
then press the [ENTER] button.

When the password has been set to the selected user box, the password entry 
screen is displayed.  In that case, continue to next step.
When the password had not been set to the selected user box, skip to Step 4.
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3 If the password entry screen is displayed, enter the 5-digit pass-
word using digital keys and press the [ENTER] button.

4 Select the folder that you want to delete and press the [DELETE] 
button.

5 Press the [YES] button to delete the selected folder.

The folder is deleted.
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Managing Documents
From the Control Panel, users can perform:

 P.45 “Deleting Documents”
 P.47 “Printing Documents”

Deleting Documents
Users can delete a document from the Control Panel.

If you want to delete all documents in a folder or box, you can delete the folder or box instead of 
deleting each document.

Deleting a document

1 Press the [e-FILING] button on the control panel.
Please note that the location of the button may be different depend-
ing on the system you are using.

2 Select a box button that contains a document you want to delete, 
and then press the [ENTER] button.

When the password has been set to the selected user box, the password entry 
screen is displayed.  In that case, continue to next step.
When the password had not been set to the selected user box, skip to Step 4.
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3 If the password entry screen is displayed, enter the 5-digit pass-
word using digital keys and press the [ENTER] button.

4 If the document is stored in a folder, select the folder and press the 
[OPEN FOLDER] button.

5 Select the document that you want to delete, and press the 
[DELETE] button.

6 Press the [YES] button to delete the selected document.

The folder is deleted.
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Printing Documents
This equipment allows users to print a document stored in e-Filing.

 P.47 “Printing an Entire Document”
 P.50 “Selecting Test Print”

— Printing an Entire Document
To print an entire document from the Control Panel, perform the following operation.

Printing a document

1 Press the [e-FILING] button on the control panel.
Please note that the location of the button may be different depend-
ing on the system you are using.

2 Select a box button that contains a document you want to print, and 
then press the [ENTER] button.

When the password has been set to the selected user box, the password entry 
screen is displayed.  In that case, continue to next step.
When the password had not been set to the selected user box, skip to Step 4.
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3 If the password entry screen is displayed, enter the 5-digit pass-
word using digital keys and press the [ENTER] button.

4 If the document is stored in a folder, select the folder and press the 
[OPEN FOLDER] button.

5 Select the document that you want to print, and press the [SET-
TINGS] button.

If you do not have to change the print settings, you can execute printing by press the 
[PRINT] button now.
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6 Set the print settings as you require (Please note that the display 
may be different depending on the system you are using).

If you want to change the number of copies, enter the number using the digital keys.
If you want to specify the drawer where the paper is fed, press the drawer in the illus-
tration in the screen or press the arrow buttons to move the selection.
If you want to perform the 2-Sided printing, press the upper left (shown as the [1 
SIDE] button in the above screen) button and change the selection to the [BOOKLET] 
or [TABLET] button.
If you want to change the finishing options, such as group printing, stapling, or hole 
punching, press the middle left button (shown as the [SORT] button in the above 
screen) and change the selection to the desired finishing option.
If you want to change the destination tray, press the lower left button (shown as the 
[TRAY 2] button in the above screen) and change the selection to desired destination 
tray.
If you want to set the image shift margin, press the [IMAGE SHIFT] button and set the 
image shift in the desired position.
If you want to print a time stamp, press the [TIME STAMP] button and select the 
desired position.
If you want to print page numbers in each page, press the [PAGE NUMBER] button 
and select the desired position.

7 Press the [PRINT] button.
The document is printed.
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— Selecting Test Print
Before printing an entire document, you can print a specified pages of the document for confir-
mation.

Printing a document

1 Press the [e-FILING] button on the control panel.
Please note that the location of the button may be different depend-
ing on the system you are using.

2 Select a box button that contains a document you want to print, and 
then press the [ENTER] button.

When the password has been set to the selected user box, the password entry 
screen is displayed.  In that case, continue to next step.
When the password had not been set to the selected user box, skip to Step 4.

3 If the password entry screen is displayed, enter the 5-digit pass-
word using digital keys and press the [ENTER] button.
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4 If the document is stored in a folder, select the folder and press the 
[OPEN FOLDER] button.

5 Select the document that you want to print, and press the [TEST 
PRINT] button.

6 Specify the “First Page” and “Last Page” field.

This screen is displayed as the “Last Page” field is selected.  If you want to specify 
the page range, enter the last page number using the digital keys in the “Last Page” 
field and press the [SET] button.  Then the “First Page” field is highlighted, and enter 
the first page number.

7 Press the [PRINT] button.
The document is printed.
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Getting Started with e-Filing Web Utility

This section describes how to manage the e-Filing functions using the e-Filing web utility.

Accessing e-Filing Web Utility
This section describes how to access and exit the e-Filing web utility and how to log in as a sys-
tem administrator.

Accessing the e-Filing Web Utility Main Page
There are two ways to access the e-Filing web utility:

Click the e-Filing web utility link in the TopAccess web site.
Enter the e-Filing web utility URL in the address field of your Web browser.
The e-Filing web utility URL is: http://[IP address]:8080/e-FilingBox/efb.asp?
The [IP address] portion will be the IP address of this equipment.  You can also use DNS 
name of this equipment instead of the IP address.
For example, IP address of this equipment is “192.168.1.2”

http://192.168.1.2:8080/e-FilingBox/efb.asp?
For example, DNS name of this equipment is “mfp-00000236”

http://mfp-00000236:8080/e-FilingBox/efb.asp?

If the SSL is enabled for the HTTP network service, e-Filing web utility also will be accessed 
using SSL.

When the User Management Setting is enabled, the login page will be displayed when access-
ing the e-Filing web utility URL.  In that case, please enter the user name and password for the 
User Authentication to login the e-Filing Web Utility Main Page.

Users can operate the e-Filing web utility after accessing the e-Filing web utility.
The access to the e-Filing web utility will be time out according to the Session Timer setting 
in the WEB General Setting in TopAccess.
To use the administrator’s functions of e-Filing web utility, you must log in as a system 
administrator after accessing the e-Filing web utility.

 P.53 “Logging On the Administrator Page”
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Logging On the Administrator Page
If you log on as a system administrator, you can edit all the documents in the user boxes or in 
the public box and can create folders in these boxes. Also, the user boxes can be deleted 
except the public box.

The Public box cannot be deleted.

Logging on as a system administrator

1 Click the Login link located at the upper right in the page.

The Administrator Login page is displayed.

2 Enter the administrator password in the “Password” field.

The administrator password is the same as the password that has been set in the 
TopAccess or Touch Panel Display for administrator.  The default administrator pass-
word is “123456” if you have not change the administrator password.

3 Click [Login].
The [Administration] tab appears in the main tabs.

You can log off from the e-Filing web utility in administrator mode.  To log off, click the 
Logout link or close your web browser.
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About Main Tabs
e-Filing web utility’s interface consists of three main tabs located in the upper-right corner of the 
web browser’s window — the Documents tab, the Preferences tab, and the Administration tab.

The main tabs enable you to display and work with your documents, set up viewing preferences, 
and perform administrative functions.

 P.54 “Documents Tab”
 P.56 “Preferences Tab”
 P.57 “Administration Tab”

In addition, the Login link is located to the right of the main tabs, which allows you to login as a 
system administrator.

 P.58 “Login Link”

Documents Tab
The Documents tab is the default page and is available to all users. It consists of a Folders and 
Documents frame, a Menu Bar, and a Contents frame.

1 4

2 3
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1) Documents Frame
The Documents frame is an Explorer-style user interface. Use the Folders and Documents 
frame to locate the folders and documents that you want to work with.
In the Documents frame, the following icons are displayed according to the items:
- Box Icons

- Folder Icons

- Document Icons

2) Menu Bar
The Menu bar is located below the main tabs: File, Edit, View, and Layout. You can use 
these menu to accelerate the command.

For more information about menu bar items, please refer to the following section.
 P.201 “Menu Functions (Web utility)”

This icon indicates a closed box.

This icon indicates a opened box.

This icon indicates a closed box that is protected by a password.

This icon indicates a opened box that is protected by a password.

This icon indicates the closed folder.

This icon indicates the opened folder.

This icon indicates a document that was stored by a print opera-
tion.  When the icon is displayed as a white icon, it indicates that 
the document is currently in View mode.  When the icon is dis-
played as a blue icon, it indicates that the document is currently 
in Edit mode.
This icon indicates a document that was stored by a scan oper-
ation.  When the icon is displayed as a white icon, it indicates 
that the document is currently in View mode.  When the icon is 
displayed as a blue icon, it indicates that the document is cur-
rently in Edit mode.
This icon indicates a document that was stored by a copy oper-
ation.  When the icon is displayed as a white icon, it indicates 
that the document is currently in View mode.  When the icon is 
displayed as a blue icon, it indicates that the document is cur-
rently in Edit mode.
This icon indicates a document that was stored by a fax opera-
tion using the Mailbox function, Fax Received Forward function, 
and Internet Fax Received Forward function.  When the icon is 
displayed as a white icon, it indicates that the document is cur-
rently in View mode.  When the icon is displayed as a blue icon, 
it indicates that the document is currently in Edit mode.
This icon indicates a document that was created by merging 
several documents.  When the icon is displayed as a white icon, 
it indicates that the document is currently in View mode.  When 
the icon is displayed as a blue icon, it indicates that the docu-
ment is currently in Edit mode.
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3) Tool Bar
The Tool bar is located below the main tabs: Send, Email, Save, Test Print, Cut, Copy, Paste, 
Beginning, Previous, Next, and End.  You can use these menu to accelerate the command.

4) Contents Frame
The Contents frame displays the documents or pages that you are working with. There are 
also document control buttons located below the menu bar.  You can use this button to 
change document status between view mode and edit mode, and use the Contents frame to 
print and edit your documents.

For more information about the document control buttons, please refer to the following sec-
tion.

 P.108 “About Document Control Buttons”

Preferences Tab
The Preferences tab is available to all users. It allows you to set default for the document view 
and the number of thumbnail images displayed on the screen.

Click this to send the selected documents as Email.
 P.219 “Send Email”

Click this to save the document.  This is enabled only when you are dis-
playing the document in Edit mode.
Click this to perform the test print.

 P.206 “Test Print”
Click this to cut the selected documents or pages.

 P.221 “Cut”
Click this to copy the selected documents or pages.

 P.221 “Copy”
Click this to paste the items that have been copied.

 P.221 “Paste”
Click this to display the first items in the Contents frame.

 P.224 “Beginning”
Click this to display the previous set of items in the Contents frame.

 P.224 “Previous”
Click this to display the items that immediately follow those displayed in the 
Content frame.

 P.224 “Next”
Click this to display the last items in the Contents frame.

 P.224 “End”

1
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4

3

5
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1) Default Document View
You can select the “Thumbnail” or “List” view. The system displays your documents in the 
selected view until you choose another option from the View menu. Default is Thumbnail 
view.

2) Load [number] thumbnail per view
Use the drop-down list to select the number of thumbnail images displayed on the screen: 4, 
8 or 12. Default is 8.

3) Display the progress bar
Check this to display the progress bar when copying, cutting, pasting the documents or 
pages, deleting pages, and saving documents.

4) [Save]
Click this button to apply your new settings.

5) [Reset]
Click this button to restore the default settings.

Administration Tab
The Administration tab allows the system administrator to manage data in the e-Filing. The 
Administration tab is only visible if you are logged on as the system administrator.
The Administration tab has following subtab:

 P.57 “Erase Box Subtab”

An administrator can also set up the e-Filing notifications using the TopAccess in the administra-
tor mode.  For more information about setting up the notifications for the e-Filing, please see the 
TopAccess Guide.

— Erase Box Subtab
This subtab enables you to manually delete user boxes that are no longer required or have 
become corrupted.  Use this feature to restore the available hard disk space.

1) e-Filing Disk Space Available
This displays the available hard disk space for storing e-Filing data.

1

2

3
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2) Box Number/Box Name/Used Capacity
This displays a list of all user boxes.  When you click the box number link, the Box Properties 
window opens and you can see the detail properties of the box.
To erase the box, select the check box in front of each box, then click [OK].

3) [OK]
Click this to delete selected boxes.  Before clicking on this, you should check the check 
boxes of user boxes that you want to delete.

You cannot delete the public box.
For instructions on how to erase user boxes, please refer to the following section.

 P.178 “Erasing Box Data”

Login Link
The “Login” link that is displayed next to the main tabs allows you to login as a system adminis-
trator.

 P.58 “Administrator Login Page”
You can perform the administrative function from the Administration tab that will be displayed 
after you login as a system administrator.

 P.57 “Administration Tab”

— Administrator Login Page
You must enter the system administrator password to login as an administrator.

1) Password
Enter the system administrator password that is same as the administrator password on the 
Touch Panel Display and TopAccess.

2) [Login]
Click this to log in as a system administrator.

3) [Cancel]
Click this to cancel log in and return to the main page.

1

2

3
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Creating and Managing Boxes and Folders
e-Filing web utility enables users to store and manage document files in the document editor/
organizer. It provides two predefined system boxes called Public and User, and users can create 
one level of folder in each box.
e-Filing web utility can restrict access to each box by user password. This section explains how 
to create and manage boxes and folders.

 P.59 “Creating Boxes and Folders”
 P.63 “Deleting Boxes and Folders”
 P.67 “Renaming Box and Folder”
 P.71 “Modifying and Displaying Box and Folder Properties”

Creating Boxes and Folders
e-Filing web utility provides two box types: Public box and User box.

Public Box
All users can access the main Public box to create, edit, move and delete public documents 
and folders. Use the Public box to store documents that any user may need to work with.
User Box
Each user can create his own user box or a user box that can be shared with other, specific 
members.  The user box also can be protected by a password.  Users can then store, dis-
play, edit and print confidential documents — which can be their own or others.  To access 
the password-protected user box, users must enter the password for the box, or the system 
administrator can access the box using his password.

Before storing documents in the e-Filing, prepare the boxes to manage documents efficiently.
 P.59 “Creating New Boxes”
 P.61 “Creating New Folders”

— Creating New Boxes
Users can create up to 200 user boxes and protect each box with a password.

Users can also create user boxes from the Control Panel.  For instructions on how to create user 
boxes from the Control Panel, please refer to the following section.

 P.38 “Creating Boxes”

Creating a user box

1 Click the [Documents] tab.
The Documents tab page is displayed.



2 Getting Started

60    Getting Started with e-Filing Web Utility

2 Make sure you are selecting “e-Filing” in the Documents frame, and 
click the [File] menu and select [New Box].

The New Box window appears.

3 Select a box number in the “Box Number” drop down box and enter 
the box name in the “Box Name” field.

Users cannot select existing box numbers in the “Box Number” drop down box.  Only 
undefined box numbers appear in the drop down box.
Box names consist of any ASCII characters except: \ / < > " % & = ' ; : * ? | # [ ] { }. Do 
not use a space or period at the beginning or end of the name. The maximum size of 
a box name is 32 characters.

4 To protect the box with a password, enter 5-digit password in the 
“Box Password” and “Confirm Password” field.

The password must be 5-digit number.
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5 Click [OK].
The created user box appears in the Documents frame.

Users can configure the advanced properties for each box such as how long the box will 
retain documents, and Email notification features.

 P.71 “Modifying Box Properties”

— Creating New Folders
Users can create up to 100 folders in each box.  However, users can only create single-level 
folders in each box.  Users cannot create subfolders in the folders.

Creating a folder in a box

1 Click the [Documents] tab.
The Documents tab page is displayed.

2 In the Documents frame, select a box where you want to create a 
folder.

3 If you select a box that is protected with a password, the Password 
Authentication window appears.  Enter the password in the “Box 
Password” field and click [OK].

You can also enter the administrator password to open the user box instead of the box 
password.
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4 Click the [File] menu and select [New Folder].

The New Folder window appears.

5 Enter the folder name in the “Name” field.

Folder names consist of any ASCII character except: \ / < > " % & = ' ; : * ? | # [ ] { }. 
Do not use a space or period at the beginning or end of the name. The maximum size 
of a folder name is 64 characters.

6 Click [OK].
The created folder appears under selected box in the Documents frame.
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Deleting Boxes and Folders
Users can delete user boxes and folders.  When the box has been protected with a password, 
users must enter the password to delete the boxes and folders.  Users can also delete folders in 
the public box, but not the public box.
Administrators also can delete all user boxes and folders using the administrator password.

 P.63 “Deleting Boxes”
 P.65 “Deleting Folders”

— Deleting Boxes
Users can delete user boxes and folders in any box.  If a user box is deleted, all folders and doc-
uments in the box are also deleted.

You can also delete user boxes from the Touch Panel Display.  For the instruction to delete user 
boxes from the Touch Panel Display, please refer to the following section.

 P.41 “Deleting Boxes”

Deleting user boxes

1 Click the [Documents] tab.
The Documents tab page is displayed.

2 In the Documents frame, select a user box that you want to delete.

You cannot delete the public box.
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3 If you select the user box, which is protected with a password, the 
Password Authentication window appears.  Enter the password in 
the “Box Password” field and click [OK].

You can also enter the administrator password to open the user box instead of the box 
password.

4 Click the [Edit] menu and select [Delete].

The confirmation message dialog box appears.

5 Click [OK].

The selected box is deleted.
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— Deleting Folders
Users can delete folders in the Public box and User box.  If a folder is deleted, all documents in 
the folder are also deleted.

You can also delete folders from the Touch Panel Display.  For the instruction to delete folders 
from the Touch Panel Display, please refer to the following section.

 P.43 “Deleting Folders”

Deleting folders

1 Click the [Documents] tab.
The Documents tab page is displayed.

2 In the Documents frame, select the box that contains folders that 
you want to delete.

3 If you select a box that is protected with password, the Password 
Authentication window appears.  Enter the password in the “Box 
Password” field and click [OK].

All folders and documents in the box are displayed in the Contents frame.

You can also enter the administrator password to open the user box instead of the box 
password.
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4 Mark the check boxes of folders that your want to delete.

Users can also delete a folder by selecting the folder in the Documents frame, clicking on 
the [Edit] menu and selecting [Delete].  In that case, make sure no documents are 
checked in the Contents frame.  If any documents are checked, they will be deleted 
instead of the selected folder.

5 Click the [Edit] menu and select [Delete].

The confirmation message dialog box appears.

6 Click [OK].

The selected folders are deleted.
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Renaming Box and Folder
Users can rename the user boxes and folders.  When the box has been protected with a pass-
word, users must enter the password to rename the box or folders.  Users can also rename fold-
ers in the public box, but cannot rename the public box.
Administrators can also rename all protected user boxes and folders using the administrator 
password.

 P.67 “Renaming Boxes”
 P.69 “Renaming Folders”

— Renaming Boxes
You can rename user boxes.

Do not turn off the power of the equipment when changing the box name.  All folders and docu-
ments in the box will be lost if the power is turned off while the system is saving a new name.

Users can rename user boxes from the Touch Panel Display.  For instructions on how to rename 
user boxes from the Touch Panel Display, please refer to the following section.

 P.40 “Editing Boxes”

Renaming user boxes

1 Click the [Documents] tab.
The Documents tab page is displayed.

2 In the Documents frame, select a user box that you want to rename.

You cannot rename the public box.
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3 If you select a user box that is protected with a password, the Pass-
word Authentication window appears.  Enter the password in the 
“Box Password” field and click [OK].

You can also enter the administrator password to open the user box instead of the box 
password.

4 Click the [File] menu and select [Rename].

The Rename Box window appears.

Make sure no folder or document is checked in the Contents frame.  If a folder or docu-
ment is checked, it will be renamed instead of the selected box.

5 Edit the name in the “Name” field and click [OK].

The confirmation dialog box appears.
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6 Click [OK].

The selected box is renamed.

— Renaming Folders
Users can rename folders in the public box and user boxes.

Do not turn off the power of the equipment when changing the folder name.  All documents in 
the folder will be lost if the power is turned off while the system is saving a new name.

Renaming folders

1 Click the [Documents] tab.
The Documents tab page is displayed.

2 In the Documents frame, select the box that contains the folder you 
want to rename.

3 If you select a box that is protected with a password, the Password 
Authentication window appears.  In this case, enter the password in 
the “Box Password” field and click [OK].

All folders and documents in the box are displayed in the Contents frame.

You can also enter the administrator password to open the user box instead of the box 
password.
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4 Check the box of the folder that your want to rename.

Do not check several folders at the same time.  You can only rename one folder at a time.

5 Click the [File] menu and select [Rename].

The Rename Folder window appears.

Users can also rename a folder by selecting the folder in the Documents frame, clicking 
on the [File] menu and selecting [Rename].  In that case, make sure no document is 
checked in the Contents frame.  If a document is checked, it will be renamed instead of 
the selected folder.
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6 Edit the name in the “Name” field and click [OK].

The confirmation dialog box appears.

7 Click [OK].

The selected folder is renamed.

Modifying and Displaying Box and Folder Properties
Users can display and modify the properties of user boxes such as the box password and main-
tenance period to automatically delete documents, and Email notification settings.  When the 
box has been protected with a password, you must enter the password to modify the box proper-
ties.  Also users can display the folder properties.
Administrators can also modify all protected user boxes properties and public box properties 
using the administrator password.

 P.71 “Modifying Box Properties”
 P.76 “Displaying Folder Properties”

— Modifying Box Properties
You can display and modify the box properties.

If you want to modify the public box properties, you must first log in as the system adminis-
trator.
You cannot modify the password of the box that any users are currently accessing.

Displaying and modifying box properties

1 Click the [Documents] tab.
The Documents tab page is displayed.
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2 In the Documents frame, select a user box whose properties you 
want to display and edit.

3 If you select a box that is protected with a password, the Password 
Authentication window appears.  Enter the password in the “Box 
Password” field and click [OK].

You can also enter the administrator password to open the user box instead of the box 
password.

4 Click the [File] menu and select [Properties].

The Box Properties window appears.  In the Box Properties window, you can see the 
box properties.
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5 If you want to edit the box properties, click [Change Properties].

The Change Box Properties window is displayed.
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6 Enter the items as described below to modify the box properties.

Change Box Password — Check this to edit the box password.  When you check on 
this, enter password in the “Old Box Password”, “New Box Password”, and “Confirm New 
Password” field.
Old Box Password — Enter the current box password.  This is enabled only when you 
check on the “Change Box Password” box.
New Box Password — Enter the new box password.  This is enabled only when you 
check on the “Change Box Password” box.
Confirm New Password — Enter the new box password again.  This is enabled only 
when you check on the “Change Box Password” box.
Delete document automatically — Check this to automatically delete the documents in 
this box.  When you check this, enter the number of days in the “Preservation Period for 
Documents” field.
Preservation Period for Documents — Enter the number of days that the documents 
will be preserved.  The documents will be deleted after the specified days have been 
passed. If you enter "1" (day), the documents will be deleted in 24 hours.
Send email when an error occurs — Check this to send a notification message to the 
specified Email address when an error occurs.  When you check this, enter an Email 
address in the “Email Address” field.
Send email when job is completed — Check this to send a notification message to the 
specified Email address when a job is completed.  When you check this, enter an Email 
address in the “Email Address” field.
Advance automatic delete notification — Check this to enable the Email notification, 
which will send a notification message to the specified Email address 3 days before it 
automatically deletes the documents.  When you check this, enter an Email address in 
the “Email Address” field.
Email Address — Enter an Email address where the notification will be sent.
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If you forget the old password, you can enter the administrator password in the “Old 
Box Password” instead of the old password.
When “Send email when an error occurs” and “Send email when job is completed” 
are enabled, the following e-Filing operations are notified.
- Scan to e-Filing
- Copy to e-Filing
- Print to e-Filing
- Fax/Internet Fax Received Forward to e-Filing
- e-Filing to Print
- e-Filing to Email

An administrator can configure the e-Filing notification setting in the TopAccess 
Administration tab -> Maintenance -> Notification page.  For more information, refer 
to the TopAccess Guide.

7 Click [Save].
The box properties are modified and the Box Properties window is displayed.

8 Click [OK] to close the Box Properties window.
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— Displaying Folder Properties
Users can only display the folder properties.

Displaying folder properties

1 Click the [Documents] tab.
The Documents tab page is displayed.

2 In the Documents frame, select the box that contains the folder 
whose properties you want to display.

3 If you select a box that is protected with password, the Password 
Authentication window appears.  Enter the password in the “Box 
Password” field and click [OK].

All folders and documents in the box are displayed in the Contents frame.

You can also enter the administrator password to open the user box instead of the box 
password.
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4 Check the box of the folder that your want to display the properties.

Do not check several folders at the same time.  You can only display the properties of 
one folder at a time.

Users can also display a folder properties by selecting a folder in the Documents frame, 
clicking on the [File] menu and selecting [Properties].  In that case, make sure no docu-
ment is checked in the Contents frame.  If a document is checked, it displays the proper-
ties of checked document instead of the selected folder.

5 Click the [File] menu and select [Properties].

The Folder Properties window appears.  In the Folder Properties window, you can 
see the box properties.
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6 Click [OK] to close the Folder Properties window.

Managing Documents
You can manage your documents using various functions of the e-Filing web utility.

 P.78 “Displaying Documents”
 P.80 “Renaming Documents”
 P.82 “Deleting Documents”
 P.84 “Printing Documents”
 P.90 “Archiving Documents”
 P.98 “Sending Email”

Displaying Documents
You can display your document image files in two ways. The document view options are:

Thumbnail view displays several files from a selected box, folder or several pages of a 
selected document. This is the default view. Use it to manage documents and files.

 P.79 “Using the Thumbnails View”
List view displays file names and properties in a tabular format. Use it to manage boxes and 
folders containing a large number of files.

 P.79 “Using the List View”
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— Using the Thumbnails View
This is the default view, unless you choose a different one. It displays a small image of each file 
or folder (if you highlight a box or folder in the left frame) or each page (if you highlight a docu-
ment in the left frame) with the file name or page number and a check box. Click the check 
boxes to select files or pages that you want to move, copy, delete or print.
To return to the Thumbnail view, go to the [View] menu and select [Thumbnail].

— Using the List View
This view displays box, folder, or file names with the properties and check boxes in a list format. 
You may find it more convenient than Thumbnail view for managing boxes and folders that con-
tain a large number of files. Click the check boxes to select a single file or multiple files that you 
want to move, copy, delete or print.
To display your files in the List view, go to the [View] menu and select [List].
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Renaming Documents
You can rename the documents.

Do not turn off the power of the equipment when changing the document name.  The document 
will be lost if the power is turned off while the system is saving a new name.

Renaming a document

1 Click the [Documents] tab.
The Documents tab page is displayed.

2 In the Documents frame, select a box or folder that contains the 
document you want to rename.

3 If you select a box that is protected with a password, the Password 
Authentication window appears.  Enter the password in the “Box 
Password” field and click [OK].

You can also enter the administrator password to open the user box instead of the box 
password.
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4 Mark the check box of the document you want to rename and select 
[Rename] from the [File] menu.

The Rename Document window opens.

Users can also rename a document by selecting the document in the Documents frame, 
clicking on the [File] menu and selecting [Rename].  In that case, even if you mark the 
check boxes of pages in the Contents frame, e-Filing operates renaming for the selected 
document in the Documents frame.

5 Enter the document name in the “Name” field and click [OK].

You can enter up to 64 characters in the “Name” field.
The confirmation dialog box appears.

6 Click [OK].

The document is renamed.
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Deleting Documents
You can delete several documents from the box or folder at the same time.

Deleting documents

1 Click the [Documents] tab.
The Documents tab page is displayed.

2 In the Documents frame, select a box or folder that contains the 
documents you want to delete.

3 If you select a box that is protected with a password, the Password 
Authentication window appears.  Enter the password in the “Box 
Password” field and click [OK].

You can also enter the administrator password to open the user box instead of the box 
password.
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4 Mark the check box of the documents you want to delete and select 
[Delete] from the [Edit] menu.

The confirmation dialog box appears.

Users can also delete a document by selecting the document in the Documents frame, 
clicking on the [Edit] menu and selecting [Delete].  In that case, make sure no pages are 
checked in the Contents frame.  If any pages are checked, the alert message will be dis-
played because pages cannot be deleted in View mode.

5 Click [OK].

The documents are deleted.
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Printing Documents
You can print documents and images from boxes and folders in the e-Filing web utility repository. 
This topic explains how to use your web browser to print an entire document.

 P.84 “Printing an Entire Document”
 P.88 “Selecting Test Print”

— Printing an Entire Document
You can print the entire document.

Printing a document

1 Click the [Documents] tab.
The Documents tab page is displayed.

2 In the Documents frame, select a box or folder that contains the 
document you want to print.

3 If you select a box that is protected with a password, the Password 
Authentication window appears.  Enter the password in the “Box 
Password” field and click [OK].

You can also enter the administrator password to open the user box instead of the box 
password.
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4 Mark the check box of the document you want to print and select 
[Print Document] from the [File] menu.

You can also print the document by selecting a document in the Documents frame and 
selecting the [Print Document] in the [File] menu.  However, you cannot print individual 
pages even if you mark the check boxes of the pages displayed in the Contents frame.

The Print Properties window appears.
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5 Set the print options as described below.

Duplex — Select whether you want the document printed on both sides of the paper.  
When you want to print the document on both sides, select “Book” to print in vertically the 
same direction to be bound along the vertical side of the paper so that the pages can be 
turned over right and left, or “Tablet” to print with a vertical reversal to be bound along the 
horizontal side of the paper so that the pages can be turned over up and down.
Number of Copies — Enter the number of copies to be printed.  You can set any integer 
from 1 to 999.
Sort Copies — Select this to output the document separately in each copy.  This is 
enabled only when you enter more than one copy in the “Number of Copies” field.
Group Copies — Select this to output the document separately in each page.  This is 
enabled only when you enter more than one copy in the “Number of Copies” field.
Rotate Sort Copies — Select this to output the document as changing the output 
orientation in each copy.  This is enabled only when you enter more than one copy in the 
“Number of Copies” field.  When this is selected, the Destination option automatically set 
to the inner tray.  To perform the Rotate Sort Copies, the portrait and landscape paper 
must be set in the different drawers.
Paper Type — Select the type of the paper desired.
Department Code — Enter the 5-digit department code, if required.  You must enter the 
department code to print a document if the department code is enabled on this 
equipment.
Paper Source — Select the paper feed source.  Please select a paper source that 
correlates with the printing size.
Destination — Select the tray to which the document will be output.
Staple — Select whether the document is stapled or not.  When you want to staple the 
document, select how the document will be stapled.
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If you enable the Staple option after enabling the Interleave Pages option, the Interleave 
Pages option will be automatically disabled.

Hole Punch — Select whether the document is hole-punched or not.  When you want to 
hole-punch the document, select how the document will be hole-punched.
Page Number - Position — Select whether the page numbers are printed on the pages.  
When you want to print the page numbers, select where the page numbers are to be 
printed.
Page Number - Initial Page — Enter the first number that applies to the first page of the 
document.  When the “Cover/Sheet Insertion - Use Front Cover” is enabled, the front 
cover is counted as the first page, and the first page of the document is counted at the 
second page.
Time Stamp - Position — Select whether the print time is printed in each page or not.  
When you want to print the time stamp, select where you want the time stamp printed.
Image Shift - Position — Select whether the printed images are shifted or not.  When 
you want to shift the printed images, select the direction to be shifted.
Shift Margin - Front — Select the width of the margin that is added to the side when the 
printed images are shifted.
Shift Margin - Back — Select the width of the margin that is added to the opposite side 
when the printed images are shifted.
Cover/Sheet Insertion - Use Front Cover — This sets front cover printing which allows 
you to insert or print a cover on a sheet fed from a different tray than the Paper Source 
option. To enable front cover printing, check on the box and select the location from 
where a cover sheet is to be fed and the print style to be used.
Cover/Sheet Insertion - Use Back Cover — This sets back cover printing which allows 
you to insert or print a cover on a sheet fed from a different tray than the Paper Source 
option. To enable back cover printing, check on the box and select the location from 
where a cover sheet is to be fed and the print style to be used.
Cover/Sheet Insertion - Insert Pages — This sets sheet insertion printing which allows 
you to insert a sheet between pages, or print a specific page on a sheet fed from a tray 
other than the Paper Source option.  This option is useful when you want to insert a blank 
sheet between chapters, or when you want to print chapter cover pages on the different 
paper.  To enable sheet insertion printing, check on the box and select the location from 
where inserted sheets are to be fed and the print style to be used.  Then, enter the page 
numbers you want to insert, and separate them with commas if multiple pages are 
specified, in the Pages field.
Cover/Sheet Insertion - Interleave Pages — This sets the interleaving page feature 
that is useful when you want to insert paper of a different type (or from another source) 
between every page of your print job. For example, you could use this option to insert 
blank, colored sheets between overhead transparencies. To enable interleaving pages, 
check on the box and select the location from where sheets are to be fed.  Also, check 
the “Duplicate” check box if you want to print previous page images on the inserted 
sheet.

If you enable the Interleave Pages option after enabling the Staple option, the Staple 
option will be automatically disabled.

Paper Type (Insert) — When you select “Bypass Tray” for the paper source of either the 
“Use Front Cover”, “User Back Cover”, “Insert Pages”, or “Interleave Pages” option, 
select the paper type for the paper fed from the Bypass Tray.
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When the User Management Setting is enabled, the maximum number of copies that is 
allowed for the department and user will be displayed in the upper right of the page.

Scheduled Print — Check this to print a job at a future date and time.  When this is 
selected, set the date and time to print a job in the “Date & Time” option.

6 Click [Print].
The document is printed and the print result window is displayed.

You can click [Cancel] to close the Print Properties window without printing.
You can click [Reset] to restore the Print Properties default settings.

7 Click [Close] to return to the Documents tab page.

When you want to stop the print of the stored document during the operation, select the 
job you want to stop from the PRINT JOB screen or SCAN JOB screen and then press 
the [DELETE] button at the Control Panel.

— Selecting Test Print
Test Print function allows you to simply print a copy of document using the default print proper-
ties settings.

Printing a document using Test Print

1 Click the [Documents] tab.
The Documents tab page is displayed.

2 Select a box or folder that contains the document you want to print 
in the Documents frame.



Getting Started with e-Filing Web Utility    89

3 If you select a box that is protected with a password, the Password 
Authentication window appears.  Enter the password in the “Box 
Password” field and click [OK].

You can also enter the administrator password to open the user box instead of the box 
password.

4 Mark the check box of the document you want to print and select 
[Test Print] from the [File] menu.

You can also perform test print by selecting a document in the Documents frame and 
selecting the [Test Print] in the [File] menu.  However, you cannot print individual pages 
even if you mark the check boxes of the pages displayed in the Contents frame.

The Test Print Properties window appears.
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5 Select whether printing all pages of the document or only specified 
pages.

All Pages — Select this to print all pages of the document.
[first page number] - [last page number] Pages — Select this to specify the pages to 
be printed.  When this is selected, enter the number of first page and last page to be 
printed in each field.
Department Code — Enter the 5-digit department code.  This must be enter only when 
the department code is enabled on the equipment.

When the User Management Setting is enabled, the maximum number of copies that is 
allowed for the department and user will be displayed in the upper right of the page.

6 Click [Print].
One copy of the document is printed and the print result window is displayed.

You can click [Cancel] to close the Test Print Properties window without printing.

7 Click [Close] to return to the Documents tab page.

When you want to stop the print of the stored document during the operation, select the 
job you want to stop from the PRINT JOB screen or SCAN JOB screen and then press 
the [DELETE] button at the Control Panel.

Archiving Documents
The e-Filing web utility allows you to archive the documents stored in the e-Filing and download 
the archived file to your computer.  This archived file is used to upload to the e-Filing in the 
equipment whose model is the same as that of yours.

 P.90 “Downloading Archived Documents”
 P.94 “Uploading Archived Documents”

— Downloading Archived Documents
You can archive the documents in the box and download it to your computer.  Use this feature to 
create a backup file of your documents in the e-Filing.  You can also use this feature to upload 
the documents to the e-Filing on the equipment whose model is the same as that of yours.
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Before archiving documents, please make sure that there are available hard disk space 
more than three times of original data size.
The archived file contains all documents you specified to the archive, but you cannot open 
the documents on your client computer.
You can create an archived file that contains documents in same folder and box.
You cannot create an archived file that contains more than 2 GB data.
Do not close the main window and child window by clicking the [X] button.  If you did, down-
loading the archived documents becomes impossible.  If you close the window by clicking 
the [X] button, turn off and on the power of the equipment.

To upload the archived file to the e-Filing, please refer to the following section.
 P.94 “Uploading Archived Documents”

Downloading an archived document

The following procedure describes an example of how to download an archived document when 
using the Microsoft Internet Explorer.

1 Click the [Documents] tab.
The Documents tab page is displayed.

2 In the Documents frame, select a box or folder that contains the 
document you want to archive.

3 If you select a box that is protected with a password, the Password 
Authentication window appears.  Enter the password in the “Box 
Password” field and click [OK].

You can also enter the administrator password to open the user box instead of the box 
password.



2 Getting Started

92    Getting Started with e-Filing Web Utility

4 Mark the check box of the document you want to archive and select 
[Archive Document] from the [File] menu.

The confirmation dialog box appears.

Users can also archive a document by selecting the document in the Documents frame, 
clicking on the [File] menu and selecting [Archive Document].  However, you cannot 
archive individual pages even if you mark the check boxes of the pages displayed in the 
Contents frame.

5 Click [OK] to start archiving.

6 The Archive Document window appears.  During the archive pro-
cess, you can quit archiving by clicking [Cancel].

After archiving is completed, “Your document has been archived successfully” will be 
displayed.
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7 Click the file name link to download the archived file.

The File Download dialog box appears.

8 Click [Save].

The Save As dialog box appears.

9 Locate the folder where you want the archived file saved and click 
[Save].

It starts downloading the file.
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10 Click [Close].

— Uploading Archived Documents
If you have archived file that downloaded from the equipment, you can upload it to the e-Filing.  
When you upload the archived file, the archived file is automatically extracted and documents 
will be created in the box specified.

Before uploading archived documents, please make sure that there are available hard disk 
space more than three times of original data size.
You cannot upload to the folder in the box: Extracted documents will be added directly to the 
box.
If a same name document already exists in the box, the extracted document will be renamed 
by adding 3-digit number to the original name.
Do not close the main window and child window by clicking the [X] button.  If you did, upload-
ing the archived documents becomes impossible.  If you close the window by clicking the [X] 
button, turn off and on the power of the equipment.

To download archived documents in the e-Filing, refer to the following section.
 P.90 “Downloading Archived Documents”

Uploading archived documents

1 Click the [Documents] tab.
The Documents tab page is displayed.
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2 Select a box in the Documents frame where you want to upload the 
documents in the Documents frame.

3 If you select a box that is protected with a password, the Password 
Authentication window appears.  Enter the password in the “Box 
Password” field and click [OK].

You can also enter the administrator password to open the user box instead of the box 
password.

4 Select [Upload Archived Document] from the [File] menu.

The Upload Archived Document window appears.
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5 Click [Browse].

The Choose File dialog box appears.

6 Select an archived file to be uploaded and click [Open].

This will return you to the Upload Archived Document window and the folder path of 
the selected file will be displayed in the “Archived File” field.

7 Click [OK].

The confirmation dialog box appears.

8 Click [OK] to start uploading.

If you select other than the archived file, the error message “File format doesn’t corre-
spond” is displayed.  If the message is displayed, make sure to select a correct archived 
file and try again.
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9 The Upload Archive Document window shows the process on 
uploading.  During the upload process, you can quit uploading by 
clicking [Cancel].

After uploading is completed, “Your document has been archived successfully” will be 
displayed.

10 Click [Close].

Returns you to the Upload Archived Document window.

11 Click [Cancel] to close the window.

The documents are added in the selected box.
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Sending Email
You can send selected documents as Emails from the e-Filing web utility.
When you perform this function, this equipment creates Email as attaching the selected docu-
ments as files and sends Email directly from the equipment.

To use the Send Email function, the Email configuration of the equipment needs to be set by the 
network administrator.

Sending e-Filing documents as Email

1 Click the [Documents] tab.
The Documents tab page is displayed.

2 In the Documents frame, select a box or folder that contains the 
document you want to archive.

3 If you select a box that is protected with a password, the Password 
Authentication window appears.  Enter the password in the “Box 
Password” field and click [OK].

You can also enter the administrator password to open the user box instead of the box 
password.
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4 Mark the check box of the document you want to send as an Email 
and select [Send Email] from the [File] menu.

The Send Email page is displayed.

You cannot send a document that is stored by Print to e-Filing function.
You cannot send a document that is stored by Copy to e-Filing function in full 
color,auto color, or gray scale mode.

Users can also send a document as an Email by selecting the document in the Docu-
ments frame, clicking on the [File] menu and selecting [Send Email].  
Users can also send up to 100 individual pages or documents by marking the check 
boxes displayed in the Contents frame.
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5 Specify the following items as required and click [Send].

[To: Destination Setting] — Click this to specify the destination.  When you click this 
button, the Recipient List page appears.  For instructions on how to specify the 
destination, see the following section.

 P.101 “Destination Setting”
[Cc: Destination Setting] — Click this to specify the Cc destination if required.
Subject — This sets the subject of the Email documents.  Select “Send from (Device 
Name) (Date) (Time)” to automatically apply the subject, or enter the desired subject in 
the field.
From Address — Enter the Email address of the sender.  When the recipient replies, the 
message will be sent to this Email address.
From Name — Enter the sender name of the Email document.
Body — Enter the body message of the Email document.  You can enter up to 1000 
characters (including spaces).
File Format — Select the file format that the received document will be converted.
Encryption — Set this for encrypting PDF files if you have selected “PDF (Multi)” or 
“PDF (Single)” in the File Format setting.
File Name — Select how the attached file will be named.  Select “DocYYMMDD” to 
name as it described, select “Original Document Name” to use the original document 
name, or you can enter the desired file name in the field.
Fragment Message Size — Select the size of the message fragmentation.
Department Code — Enter the department code if required.
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6 Click [Close].

— Destination Setting
In the Recipient List page, you can specify the destinations to send e-Filing documents as Email.
You can specify the recipients by entering Email addresses manually, selecting recipients from 
the address book, selecting recipient groups from the address book, or searching for recipients 
in the LDAP server.

 P.101 “Entering the recipients manually”
 P.102 “Selecting the recipients from the address book”
 P.104 “Selecting the groups from the address book”
 P.105 “Searching for recipients in the LDAP server”
 P.106 “Removing the contacts from the recipient list”

Entering the recipients manually

Using this method, you can add a recipient manually to the Recipient List.

1 Click [Destination Setting] to open the Recipient List page.

2 Click [New].

The Contact Property page is displayed.

3 Enter the Email address of the recipient, in the Destination field.

4 Click [OK].
Entered recipient is added in the Recipient List page.
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5 Repeat step 2 to 4 to add all recipients you require.

You can remove the contacts that you added in the recipient list before saving the desti-
nation settings.

 P.106 “Removing the contacts from the recipient list”

6 Click [Save].

The contacts are added as the destinations.

Selecting the recipients from the address book

By this method, you can select recipients from the address book.

1 Click [Destination Setting] to open the Recipient List page.

2 Click [Address Book].

The Address Book page is displayed.
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3 Check the Email boxes of users you want to add as the recipients.

If you want to sort recipient list by a specific group, select the desired group name at the 
Group drop down box.

4 Click [ADD].
The selected recipients are added in the Recipient List page.

You can remove the contacts that you added in the recipient list before saving the desti-
nation settings.

 P.106 “Removing the contacts from the recipient list”

5 Click [Save].

The contacts are added as the destinations.
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Selecting the groups from the address book

By this method, you can select groups from the address book.

1 Click [Destination Setting] to open the Recipient List page.

2 Click [Address Group].

The Address Group page is displayed.

3 Check the Group boxes that contain the desired recipients.

4 Click [ADD].
All recipients in the selected groups are added in the Recipient List page.

You can remove the contacts that you added in the recipient list before saving the desti-
nation settings.

 P.106 “Removing the contacts from the recipient list”

5 Click [Save].

The contacts are added as the destinations.
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Searching for recipients in the LDAP server

By this method, you can search for recipients in the registered LDAP server and in the address 
book.

1 Click [Destination Setting] to open the Recipient List page.

2 Click [Search].

The Search Contact page is displayed.

3 Select the directory service name that you want to search in the 
“Directory Service Name” field, and enter the search terms in the 
fields that you want to search.

If you select the model name of this equipment at the Directory Service Name drop 
down box, you can search for recipients in the address book of this equipment.
TopAccess will search for the recipients that match the entries.
Leaving the field blank allows wild card searching.  (However, you must specify one 
of them.)

4 Click [Search].
TopAccess will start searching for recipients in the LDAP server and the Search 
Address List page will display the results.
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5 Check the Email boxes of users you want to add.

6 Click [ADD].
The selected recipients are added in the Recipient List page.

You can remove the contacts that you added in the recipient list before saving the desti-
nation settings.

 P.106 “Removing the contacts from the recipient list”

7 Click [Save].

The contacts are added as the destinations.

Removing the contacts from the recipient list

1 Check the check boxes of the contacts that you want to remove 
from the recipient list, and click [Delete].

The selected contacts are removed from the recipient list.
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About Document Control Buttons

e-Filing web utility allows you to make changes to your stored documents before you print them.
Three document control buttons are provided in the e-Filing web utility: [Edit], [Save], and [Can-
cel].
These buttons are displayed at the top of the Contents frame when you selecting a document in 
the Documents frame.  The buttons displayed vary depending on the document status.

[Edit] Button — Click this to start editing the document.  Only this button is displayed when 
you are in the View mode, where the document status indicates “View”.  When you click 
[Edit], the document status will be “Editing”, the [Save] button and [Cancel] button appear 
instead of the [Edit] button, and you can edit the document.  If you click this button when the 
document status indicates “In Use”, you cannot enter the Edit mode and the message “The 
Document is being used.  Please try again later.” is displayed.
[Save] Button — Click this to save the document that you edit.  This button is displayed only 
when you are in the Edit mode, where the document status indicates “Editing”.  When you 
click this, the document is saved and returns to the View mode.
[Cancel] Button — Click this to return to the View mode without saving the document.  This 
button is displayed only when you are in the Edit mode, where the document status indicates 
“Editing”.

The document status is displayed next at the left of these buttons.  The document status indi-
cates the following status:

In Use — This indicates another user currently edits the document.
View — This indicates the document is currently in the View mode, and you can only view 
the pages within the document.
Editing — This indicates the document is currently in the Edit mode, and you can edit the 
document.
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Working with Pages in Your Documents

e-Filing web utility lets you copy, move, delete and insert pages and change the order of pages 
in your document.

 P.109 “Displaying Document and Page Properties”
 P.110 “Copying Pages from One Document to Another”
 P.116 “Copying Pages from a Document to a Box or Folder”
 P.121 “Deleting Pages from a Document”
 P.124 “Inserting a Blank Page into Documents”
 P.128 “Moving Pages within a Document”

Displaying Document and Page Properties
You can display the Document Properties and Page Properties window that contains the details 
of the document or page.  To display the Document Properties window, mark the check box of a 
document and select [Properties] from the [File] menu.  To display the Page Properties window, 
mark the check box of a page and select [Properties] from the [File] menu.

The Document Properties window contains following information:

Location where the document is stored.
Total page number
Size of the document
Created date and time
Last modified date and time
Last accessed date and time
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The Page Properties window contains following information:

Format of the page that indicates how the page will be stored
Resolution of the page (dpi)
Image size of the page (pixel)
Paper size of the page
Size of the page

Copying Pages from One Document to Another
You can copy or cut pages from a document and insert them into another one. You must have 
“write access” to the folder containing the document to which you want to copy pages.

Copying or cutting pages and inserting them into another document

1 Click the [Documents] tab.
The Documents tab page is displayed.

2 In the Documents frame, select a box or folder that contains the 
document you want to copy.
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3 If you select a box that is protected with a password, the Password 
Authentication window appears.  Enter the password in the “Box 
Password” field and click [OK].

You can also enter the administrator password to open the user box instead of the box 
password.

4 In the Documents frame, select the document that you want to 
copy.

The pages of the document are displayed in the Contents frame.

5 If you want to cut pages instead of copy them, click [Edit] to enter 
the Edit mode.

The Contents frame displays the pages in the Edit mode.

To cut pages from the document, you must enter to the Edit mode.  If you want to copy 
pages from the document, you do not need to enter the Edit mode.

If the document status indicates “In Use”, you cannot enter the Edit mode because 
another user currently edits the document.
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6 Mark the check boxes of the pages that you want to copy and select 
[Copy] or [Cut] from the [Edit] menu.

7 If you cut pages from the document, click [Save] to save the docu-
ment.

The Save Document window appears.
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8 Enter the document name in the “Document Name” field and click 
[Save].

If you rename the document name, the document will be saved as new document.  If 
you do not change the document name, the original document will be overwritten.
The Contents frame displays the pages in the View mode.

Do not close the Save Document window by clicking the [X] button.  The operations may 
no longer work properly.  If you close the window by clicking the [X] button, turn off and 
on the power of the equipment.

9 In the Documents frame, select a box or folder that contains the 
document you want to insert the copied pages.

10 If you select a box that is protected with a password, the Password 
Authentication window appears.  Enter the password in the “Box 
Password” field and click [OK].

You can also enter the administrator password to open the user box instead of the box 
password.
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11 In the Documents frame, select the document into which you want 
to insert the copied pages.

The pages of the document are displayed in the Contents frame.

12 Click [Edit] to enter the Edit mode.
The Contents frame displays the pages in the Edit mode.

If the document status indicates “In Use”, you cannot enter the Edit mode because 
another user currently edits the document.

13 Click the space between the pages where you want to insert the 
copied pages.

The arrow indicators move to the space between the pages where you clicked.
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14 Click the [Edit] menu and select [Paste].

The copied pages are inserted between the pages.

15 Click [Save].

The Save Document window appears.
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16 Enter the document name in the “Document Name” field and click 
[Save].

If you rename the document, it will be saved as a new document.  If you do not 
change the name, the original document will be overwritten.
The document is saved and returns you to the View mode.

Do not close the Save Document window by clicking the [X] button.  The operations may 
no longer work properly.  If you close the window by clicking the [X] button, turn off and 
on the power of the equipment.

Copying Pages from a Document to a Box or Folder
You can copy or cut pages from a document and insert them in a box or folder.

Copying or cutting pages and creating a new document

1 Click the [Documents] tab.
The Documents tab page is displayed.

2 In the Documents frame, select a box or folder that contains the 
document you want to copy.
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3 If you select a box that is protected with a password, the Password 
Authentication window appears.  Enter the password in the “Box 
Password” field and click [OK].

You can also enter the administrator password to open the user box instead of the box 
password.

4 In the Documents frame, select the document that you want to 
copy.

The pages of the document are displayed in the Contents frame.

5 If you want to cut pages instead of copy them, click [Edit] to enter 
the Edit mode.

The Contents frame displays the pages in the Edit mode.

To cut pages from the document, you must enter to the Edit mode.  To copy pages from 
the document, you need not enter the Edit mode.

If the document status indicates “In Use”, you cannot enter the Edit mode because 
another user currently edits the document.
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6 Mark the check boxes of the pages that you want to copy and select 
[Copy] or [Cut] from the [Edit] menu.

7 If you cut pages from the document, click [Save] to save the docu-
ment.

The Save Document window appears.
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8 Enter the document name in the “Document Name” field and click 
[Save].

If you rename the document, it will be saved as a new document.  If you do not 
change the name, the original document will be overwritten.
The Contents frame displays the pages in the View mode.

Do not close the Save Document window by clicking the [X] button.  The operations may 
no longer work properly.  If you close the window by clicking the [X] button, turn off and 
on the power of the equipment.

9 Select a box or folder where you want to insert the copied pages in 
the Documents frame.
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10 If you select a box that is protected with a password, the Password 
Authentication window appears.  Enter the password in the “Box 
Password” field and click [OK].

You can also enter the administrator password to open the user box instead of the box 
password.

11 Click the [Edit] menu and select [Paste].

The document containing the copied page is created in the selected box or folder.
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Deleting Pages from a Document
You can delete pages from the document.

Deleting pages from a document

1 Click the [Documents] tab.
The Documents tab page is displayed.

2 In the Documents frame, select a box or folder that contains the 
document whose pages you want to delete.

3 If you select a box that is protected with a password, the Password 
Authentication window appears.  Enter the password in the “Box 
Password” field and click [OK].

You can also enter the administrator password to open the user box instead of the box 
password.



3 How to Edit Documents

122    Working with Pages in Your Documents

4 In the Documents frame, select the document whose pages you 
want to delete.

The pages of the document are displayed in the Contents frame.

5 Click [Edit] to enter the Edit mode.
The Contents frame displays the pages in the Edit mode.

If the document status indicates “In Use”, you cannot enter the Edit mode because 
another user currently edits the document.

6 Mark the check boxes of the pages that you want to delete and 
select [Delete] from the [Edit] menu.

The confirmation dialog box appears.
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7 Click [OK].

The selected pages are deleted.

8 Click [Save] to save the document.

The Save Document window appears.

9 Enter the document name in the “Document Name” field and click 
[Save].

If you rename the document, it will be saved as a new document.  If you do not 
change the name, the original document will be overwritten.
The Contents frame displays the pages in the View mode.

Do not close the Save Document window by clicking the [X] button.  The operations may 
no longer work properly.  If you close the window by clicking the [X] button, turn off and 
on the power of the equipment.
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Inserting a Blank Page into Documents
You can insert the blank page into a document. You can select a different size for the blank 
pages.

Inserting a blank page into the document

1 Click the [Documents] tab.
The Documents tab page is displayed.

2 In the Documents frame, select a box or folder that contains the 
document you want to insert a blank page.

3 If you select a box that is protected with a password, the Password 
Authentication window appears.  Enter the password in the “Box 
Password” field and click [OK].

You can also enter the administrator password to open the user box instead of the box 
password.
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4 In the Documents frame, select the document into which you want 
to insert a blank page.

The pages of the document are displayed in the Contents frame.

5 Click [Edit] to enter the Edit mode.
The Contents frame displays the pages in the Edit mode.

If the document status indicates “In Use”, you cannot enter the Edit mode because 
another user currently edits the document.

6 Click the space between the pages where you want to insert a blank 
page.

The arrow indicators move to the space between the pages where you clicked.
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7 Click the [Layout] menu and select [Insert Blank Page].

The Insert Blank Page window appears.

8 Select the paper size and orientation of the inserted blank page, 
and click [OK].

* The e-STUDIO352/452, e-STUDIO353/453 is used in the screenshot above. It may be different 
with your system.
A blank page is inserted between the pages.
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9 Click [Save].

The Save Document window appears.

10 Enter the document name in the “Document Name” field and click 
[Save].

If you rename the document, it will be saved as a new document.  If you do not 
change the name, the original document will be overwritten.
The document is saved and returns you to the View mode.

Do not close the Save Document window by clicking the [X] button.  The operations may 
no longer work properly.  If you close the window by clicking the [X] button, turn off and 
on the power of the equipment.
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Moving Pages within a Document
You can move pages within a document to arrange the page order.

Moving pages within a document

1 Click the [Documents] tab.
The Documents tab page is displayed.

2 In the Documents frame, select a box or folder that contains the 
document whose pages you want to arrange.

3 If you select a box that is protected with a password, the Password 
Authentication window appears.  Enter the password in the “Box 
Password” field and click [OK].

You can also enter the administrator password to open the user box instead of the box 
password.
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4 In the Documents frame, select the document whose pages you 
want to arrange.

The pages of the document are displayed in the Contents frame.

5 Click [Edit] to enter the Edit mode.
The Contents frame displays the pages in the Edit mode.

If the document status indicates “In Use”, you cannot enter the Edit mode because 
another user currently edits the document.

6 Mark the check boxes of the pages that you want to move between 
other pages and select [Cut] from the [Edit] menu.

The selected pages are copied to the clipboard and deleted from the document.
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7 Click the space between the pages where you want to insert the 
copied pages.

The arrow indicators move to the space between the pages where you clicked.

8 Click the [Edit] menu and select [Paste].

The copied pages are inserted between the pages.

9 Continue the procedure from Step 6 to 8 to arrange pages.
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10 After you complete arranging the pages, click [Save].

The Save Document window appears.

11 Enter the document name in the “Document Name” field and click 
[Save].

If you rename the document, it will be saved as new document.  If you do not change 
the name, the original document will be overwritten.
The document is saved and returns you to the View mode.

Do not close the Save Document window by clicking the [X] button.  The operations may 
no longer work properly.  If you close the window by clicking the [X] button, turn off and 
on the power of the equipment.
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Moving and Merging Documents

You can also move documents between boxes or folders.  You can also combine several docu-
ments into one document.

 P.132 “Moving Documents”
 P.134 “Merging Documents”

Moving Documents
You can copy a document from one box or folder to another, to help you manage the documents.

Moving documents from one box or folder to another

1 Click the [Documents] tab.
The Documents tab page is displayed.

2 In the Documents frame, select a box or folder that contains the 
document you want to move.

3 If you select a box that is protected with a password, the Password 
Authentication window appears.  Enter the password in the “Box 
Password” field and click [OK].

You can also enter the administrator password to open the user box instead of the box 
password.
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4 Mark the check boxes of the documents you want to move and 
select [Cut] from the [Edit] menu.

The selected documents are copied in the clipboard and deleted from the current box 
or folder.

5 In the Documents frame, select a box or folder where you want to 
paste the documents.

6 If you select a box that is protected with a password, the Password 
Authentication window appears.  Enter the password in the “Box 
Password” field and click [OK].

You can also enter the administrator password to open the user box instead of the box 
password.
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7 Click the [Edit] menu and select [Paste].

The documents are created in the selected box or folder.

Merging Documents
You can copy an entire document and insert its pages into another document.
The document that you want to insert is the source document. The document that you want to 
merge it into is the destination document.

Merging documents into a document

1 Click the [Documents] tab.
The Documents tab page is displayed.

2 In the Documents frame, select a box or folder that contains the 
source documents.
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3 If you select a box that is protected with a password, the Password 
Authentication window appears.  Enter the password in the “Box 
Password” field and click [OK].

You can also enter the administrator password to open the user box instead of the box 
password.

4 Mark the check boxes of the source documents and select [Copy] 
from the [Edit] menu.

The selected documents are copied in the clipboard.

5 In the Documents frame, select a box or folder that contains the 
destination document.
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6 If you select a box that is protected with a password, the Password 
Authentication window appears.  Enter the password in the “Box 
Password” field and click [OK].

You can also enter the administrator password to open the user box instead of the box 
password.

7 In the Documents frame, select the destination document.

The pages of the document are displayed in the Contents frame.

8 Click [Edit] to enter the Edit mode.
The Contents frame displays the pages in the Edit mode.

If the document status indicates “In Use”, you cannot enter the Edit mode because 
another user currently edits the document.
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9 Click the space between the pages where you want to merge the 
documents.

The arrow indicators move to the space between the pages where you clicked.

10 Click the [Edit] menu and select [Paste].

The copied documents are merged between the pages.

If the multiple documents have been copied, the documents are merged in an order from 
oldest one.



3 How to Edit Documents

138    Moving and Merging Documents

11 Click [Save].

The Save Document window appears.

12 Enter the document name in the “Document Name” field and click 
[Save].

If you rename the document, it will be saved as a new document.  If you do not 
change the name, the original document will be overwritten.
The document is saved and returns you to the View mode.

Do not close the Save Document window by clicking the [X] button.  The operations may 
no longer work properly.  If you close the window by clicking the [X] button, turn off and 
on the power of the equipment.
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Installing e-Filing Client Software

The e-Filing feature uses several utilities supplied with this equipment.

TWAIN Driver
This software component enables you to import e-Filing documents into TWAIN-compliant appli-
cations.

File Downloader
This software component enables you to import e-Filing documents into your hard disk.

Planning for Installation
This equipment supports importing into client computers the scan images saved in e-Filing, 
using the TWAIN driver and File Downloader.

* e-STUDIO352/452 is used in the illustration above. It may be different with your system.
The TWAIN driver and File Downloader can retrieve the documents that are stored in the e-Fil-
ing by the Copy to e-Filing, Print to e-Filing, Scan to e-Filing, and Received Fax and Internet Fax 
to e-Filing functions.  The TWAIN driver can be selected the TWAIN compliant applications such 
as Adobe Photoshop and retrieve document from e-Filing. The File Downloader can work as an 
application to import e-Filing documents to your local hard disk.
The TWAIN driver and File Downloader can connect to this equipment over TCP/IP network.

System Requirements for TWAIN Driver and File Downloader
The TWAIN driver and File Downloader are available for following environments:

Display Resolution
1024 x 768 dots or more
Display Color
High Color (16bit) or higher is recommended
CPU
Pentium 133 MHz minimum (Pentium 266 MHz or faster recommended)
OS
Windows 98 (Recommended Windows 98 Second Edition)
Windows Me
Windows NT 4.0 Service Pack 6a
Windows 2000 Service Pack 4
Windows XP Service Pack 1/Service Pack 2
Windows Vista
Windows Server 2003 Service Pack 1

Windows 98
Windows Me
Windows NT 4.0
Windows 2000
Windows XP
Windows Vista
Windows Server 2003

Connecting over TCP/IP Network

Retrieving from e-Filing
documents into your PC

e-Filing
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Required Software
TWAIN compliant software
Microsoft Internet Explorer 5.5 Service Pack 2 or later must be installed (for the IPv4 only)
Microsoft Internet Explorer 7.0 or later must be installed (for the IPv6 only)
Microsoft Internet Explorer is enabled to access the e-Filing web utility on this equipment.
- The proxy settings must be configured correctly to enable the access.
- The browser must not be offline.

Recommended Memory
For the black and white model: 256 MB
For the color model:
For retrieving A4/LT 600dpi color image / 600dpi black image: 256 MB

Before Installing Client Software
Before installing the client software, confirm the followings to perform an appropriate installation.

— When e-Filing Client Software Have Been Installed
If the e-Filing client software have been installed from other e-STUDIO Client Utilities CD-ROM, 
uninstall the e-Filing client software then install them from the e-STUDIO3510c Series, e-
STUDIO451c Series, e-STUDIO850 Series, e-STUDIO853 Series, e-STUDIO452 Series, e-
STUDIO453 Series, e-STUDIO282 Series or e-STUDIO283 Series Client Utilities CD-ROM. The 
e-Filing client software can be used for e-STUDIO3510c Series, e-STUDIO451c Series, e-
STUDIO850 Series, e-STUDIO853 Series, e-STUDIO452 Series, e-STUDIO453 Series, e-
STUDIO282 Series, e-STUDIO283 Series, e-STUDIO4511 Series, e-STUDIO450 Series, and e-
STUDIO280 Series.  When you uninstall the e-Filing client software, please click [No] at the dia-
log box that displays the message to delete the settings for the e-Filing client software so that 
you can restore the settings after installing new one.

Installing e-Filing Client Software
You can install e-Filing client software from the Client Utilities CD-ROM or TopAccess.

Installing from Client Utilities CD-ROM
This section describes how to install the e-Filing client software.

Installing the e-Filing client software using the installer

This procedure describes an installation on Windows XP.  The procedure is the same when 
other versions of Windows are used. The e-STUDIO352/452 is used in the illustrations below. 
They may be slightly different with your system.

You must log into Windows as a user who has the “Administrators” privilege, when using the 
Windows NT 4.0, Windows 2000, Windows XP, or Windows Server 2003.
When using Windows Vista, you can install by entering the Administrator password at the 
time of starting the installer, although you have not logged in as a user with Administrator 
privilege.

1 Insert the Client Utilities CD-ROM into the CD-ROM drive.
If the installer does not automatically start, use the Explorer to open the e-STUDIO 
folder in the Client Utilities CD-ROM and double-click “SetupLauncher.exe.”
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2 Select “I agree to the terms of the License Agreement.” and click 
[Next].

To change the display language, select a desired language from the Select Language 
drop-down menu.
The main menu window is displayed.

3 From the menus, select “Custom Install.”

Custom Install: Select this if you would like to pick and choose the installation 
components.

In addition to the above menus, the main menu window has the Printer Driver, the Scan 
Driver and Utility and the Fax Driver menus. For more information about these drivers 
and utilities, please see the Printing Guide, the Scanning Guide, and the Network Fax 
Guide.
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4 Select the software that you want to install and click [Next].

The following software can be installed:
TOSHIBA e-STUDIO TWAIN Driver
TOSHIBA e-STUDIO File Downloader

There are also printing software, scan software, and fax software in the list. For more 
information about each software, please see the Printing Guide, the Scanning Guide, 
and the Network Fax Guide.

5 Confirm the list of the software to install and click [Install].

If you install AddressBook Viewer and/or File Downloader, you can change the folder 
where these programs are installed. Click [Browse] and, when the Browse For Folder 
dialog box appears, select a folder and click [OK].
The installation starts.



4 Retrieving Documents

144    Installing e-Filing Client Software

If you have selected a printer or fax driver in Step 4, the window for specifying the net-
work path or queue name of your device is displayed. In this case, see the Printing 
Guide or the Network Fax Guide.

6 When the installation is complete, click [Finish].

The main menu window is displayed.

The Installer may ask you to restart your computer. If it does, select “Yes, I want to restart 
my computer now.” and click [Finish] to restart your computer.

7 Click [Yes].
When a message appears asking whether to finish the installation, click [Yes].

8 The installation is completed.

Installing from TopAccess
If the system administrator has uploaded the software to this equipment, you can use TopAc-
cess to install the software on your workstation.

When using Windows Server 2003 that the Service Pack is installed, the installation from 
TopAccess cannot be performed.  In that case, please install the software in the other 
method.
For instructions on how to upload the software in the equipment, please refer to the TopAc-
cess Guide.
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Installing e-Filing client software from TopAccess

1 In TopAccess, click the Install Software link at the bottom of the 
screen.

* Please note that the screen may be slightly different depending on the system you are using.
The Install Client Software page opens.

2 Click the “Install Client1” link to download the installer file.

3 Download the installer file on your desktop by following the 
prompts.

4 Double-click the “InstallClient1.exe” file that you downloaded.
The installer starts and the InstallShield Wizard dialog box appears.
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5 Follow the installation procedure using the Client Utilities CD-ROM 
described in following section.

 P.141 “Installing from Client Utilities CD-ROM”

Uninstalling e-Filing Client Software
The following describes how to uninstall e-Filing client software.

Uninstalling e-Filing Client Software

The following describes an uninstallation on Windows XP.  The procedure is the same when 
other versions of Windows are used. The e-STUDIO352/452 is used in the screens below. They 
may be slightly different with your system.

1 Open “Control Panel” and click the “Add or Remove Programs” 
icon.

The Add/Remove Programs dialog box appears.
When using Windows Vista, select [Start], [Control] select [Program] and uninstall 
theprogram.
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2 From the list, select the software you want to remove and click 
[Remove].

3 Click [Yes].

4 Click [Yes] to delete the setting files.

Deleting files starts.

If you want to re-install the client software later, click [No] to remain the setting files. You-
can restore the data and settings when you re-install the client software.
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Repairing Client Software
When the client software will not work correctly, you can repair the client software.

Repairing Client Utilities Software

The following describes an installation on Windows XP.  The procedure is the same when other 
versions of Windows are used. The e-STUDIO352/452 is used in the screens below. They may 
be slightly different with your system.

Do not perform preparing the client software on Windows XP that the Service Pack 2 is not 
installed.  In that case, uninstall the client software and then install again to repair the client soft-
ware.

1 Insert the Client Utilities CD-ROM into the CD-ROM drive.
When inserting the Client Utilities CD-ROM, the installer may automatically start. 
Click [Exit] to exit the installer and continue the operation.

2 Open the software folder that you want to repair and double click 
the [Setup.exe] icon.

To repair TWAIN Driver, locate
“[CD-ROM drive]:\Client\TWAIN”.
To repair File Downloader, locate
“[CD-ROM drive]:\Client\FD”.

3 Select the language and click [OK].

4 Click [Next].

5 Click [Yes].
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6 Select “Repair” and click [Next].

7 Click [Install].

Repairing files starts.

8 Click [Finish] to close the wizard.
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Retrieving e-Filing Documents

You can retrieve the e-Filing documents using the following client software:

TWAIN Driver
This software component enables you to import e-Filing documents into TWAIN-compliant appli-
cations.

 P.150 “Importing e-Filing Document into an Application”

File Downloader
This software component enables you to import e-Filing documents into your hard disk.

 P.153 “Retrieving documents as Files”

How to Import e-Filing Documents
When a document is saved in e-Filing on this equipment, you can retrieve it using a TWAIN-
compliant software application such as “Imaging for Windows”, a Windows 98, Me, and 2000 
operating system accessory.  Also you can launch the File Downloader to retrieve the document 
from e-Filing.

Some applications that support TWAIN formats may not work with the TWAIN Driver. Refer 
to the application’s manual or online Help in that case.
Windows NT 4.0, Windows XP, Windows Vista, and Windows Server 2003 operating system 
does not come with TWAIN application software installed; you must obtain the software sep-
arately.

Importing e-Filing Document into an Application
The TWAIN driver allows you to import an e-Filing document into your TWAIN-compliant appli-
cation.

Before retrieving the stored document in e-Filing using the TWAIN driver, you should perform 
the Copy to e-Filing, Print to e-Filing, or Scan to e-Filing operations.  You can also store the 
received faxes or Internet Faxes in e-Filing using Fax and Internet Fax Received Forward or 
mailbox features when the optional Fax unit is installed.
Some applications cannot import the multi-page documents that contain color pages and 
black pages, pages of different sizes, and pages of different resolution.  In that case, please 
import the document page by page, or save the document as a TIFF or PDF file using File 
Downloader then open it with the application.
The image quality of an imported document varies depending on the application.  If the 
image quality is not good enough, use other applications, or save the document using File 
Downloader.

Retrieving stored documents from e-Filing using the TWAIN driver

1 Run the TWAIN-compliant application.

2 Click the [File] menu and select [Select Device] (or the same func-
tional command).

The Select Source dialog box appears.
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3 Select “e-STUDIO TWAIN driver” and click [OK].

4 Click the [File] menu and select [Acquire Image] (or the same func-
tional command).

The TWAIN Driver for e-STUDIO window opens.

When you are running the TWAIN driver the first time, the TopAccessDocMon Local Dis-
covery dialog box appears.  In this case, search the equipment in your network and con-
figure the connection.

 P.156 “When You Are Running the First Time”

5 In the box tree window, browse the box where the desired e-Filing 
document is saved.

6 If the selected Box requires a password, the Password dialog box 
appears.  Enter the 5-digit password of the Box and click [OK].

You can enter the administrator password instead of the 5-digit password.
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7 Select an e-Filing document (or pages) that you want to retrieve and 
click [Acquire].

The message “Do you want to Remove the Selected Page(s) or Document after 
retrieval?” is displayed.

If displaying the thumbnails of the documents takes a long time, you can stop listing them by 
pressing the [ESC] key.  Then repeat the operation from Step 1 and select [List] in the [View] 
menu to display the document in the List view.
If the selected box, folder, or document has more than 350 contents to display, it automati-
cally displays the contents in the List view.
You can also do following using the TWAIN Driver interface:

 P.162 “Deleting e-Filing Documents”
 P.171 “Displaying the Box, Folder, Document and Page Properties”
 P.174 “Shrinking Documents”
 P.174 “Adding a New Device Using Network Discovery”
 P.175 “Changing the Target Device for Retrieving e-Filing Documents”

8 If you want to remove the document from e-Filing after retrieving, 
click [Yes].  If you want to leave the document in e-Filing, click [No].

You can cancel retrieving a document by clicking [Cancel].

9 The Download In Progress dialog box appears.  After completing 
the download, the document is displayed in the application.
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Retrieving documents as Files
The File Downloader allows you to retrieve e-Filing documents and save them on your hard disk.

Before retrieving e-Filing documents using the File Downloader, you should perform the Copy to 
e-Filing, Print to e-Filing, or Scan to e-Filing operations.  You can also store the received faxes 
or Internet Faxes in e-Filing using Fax and Internet Fax Received Forward or mailbox features 
when the optional Fax unit is installed.

Retrieving e-Filing documents using the File Downloader

1 Click the [Start] menu, select [All Programs], and click [TOSHIBA e-
STUDIO File Downloader] in the [TOSHIBA e-STUDIO Client] pro-
gram folder.

The e-STUDIO File Downloader window opens.

When you are running the File Downloader the first time, the TopAccessDocMon Local 
Discovery dialog box appears.  In this case, search the equipment in your network and 
configure the connection.

 P.156 “When You Are Running the First Time”
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2 In the box tree window, browse the box where the desired docu-
ment is saved.

3 If the selected Box requires a password, the Password dialog box 
appears.  Enter the 5-digit password of the Box and click [OK].

You can enter the administrator password instead of the 5-digit password.

4 Select a document and click [Save As].

The message “Do you want to Remove the Selected Page(s) or Document after 
retrieval?” is displayed.
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If displaying the thumbnails of the documents takes a long time, you can stop listing 
them by pressing the [ESC] key.  Then repeat the operation from Step 1 and select 
[List] in the [View] menu to display the document in the List view.
If the selected box, folder, or document has more than 350 contents to display, it auto-
matically displays the contents in the List view.
You can also do following using the File Downloader interface:

 P.162 “Deleting e-Filing Documents”
 P.163 “Setting the Automatic Download”
 P.171 “Displaying the Box, Folder, Document and Page Properties”
 P.174 “Shrinking Documents”
 P.174 “Adding a New Device Using Network Discovery”
 P.175 “Changing the Target Device for Retrieving e-Filing Documents”

5 If you want to remove the document from e-Filing after retrieving, 
click [Yes].  If you want to leave the document in e-Filing, click [No].

You can cancel retrieving a document by clicking [Cancel].
The Save As dialog box appears.

6 Locate the folder where you want to save the document. Enter the 
file name in the “File Name” field, select the file format in the “Save 
as type” drop down box, and then click [Save].

The document is saved in specified folder.
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How to use TWAIN Driver and File Downloader
You can retrieve, delete, and display e-Filing documents using the TWAIN driver and File Down-
loader interface.

When You Are Running the First Time
When you access the TWAIN driver or File Downloader the first time, the TopAccessDocMon 
Local Discovery dialog box appears.  In this case, search the equipment in your network and 
configure the connection.

You can also change a target device to retrieve e-Filing documents.  To do this, you must add an 
additional connection to the other equipment using the Local Discovery function.

Discovering the device automatically

1 In the TopAccessDocMon Local Discovery dialog box, click [Start 
Discovery] to begin the process.

It locates all the compatible devices in your network.

2 When the process is completed, found devices are listed in the list.

If the process continues for a long time, it is because too many network clients are on the 
network.  In that case, you can configure the discovery using the [Advanced] button.

 P.159 “Configuring Discovery Settings”
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3 Select the equipment that you want to connect from the list and 
click [OK].

You are connected to the selected device and the TWAIN driver or File Downloader 
window is displayed.

Discovering the device manually

1 In the TopAccessDocMon Local Discovery dialog box, click [Manual 
Selection].

The Manual Selection dialog box appears.
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2 Enter each item to specify the network address of the device and 
click [OK].

IP Address — Enter the IP address of the printer.
IPX Address — This is disabled because the TWAIN driver and File Downloader do not 
support the IPX/SPX connection.
Name — Enter the printer name.
Location — Enter the location of the printer.

You must enter “Name” and “IP Address”.

3 The entered printer is added in the list.  Select the printers that you 
want to monitor from the list and click [OK].

The TWAIN driver or File Downloader connects to the selected device and displays 
the TWAIN Driver for e-STUDIO window or e-STUDIO File Downloader window.
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— Configuring Discovery Settings
You can configure the discovery settings.

1) Devices
Click the arrow button to display the poll down list and check the model name that you want 
to search.

2) Network - Enable IPX/SPX Search
This is disabled because the TWAIN driver and File Downloader do not support the IPX/SPX 
connection.

3) Network - Enable TCP/IP Search
Select this to search for devices connected to the TCP/IP network.  This is available only 
when the TCP/IP protocol is installed.
When this is enabled, select how it searches devices in the TCP/IP network.
- Search local subnet — Select this to search devices in local subnet.
- Specify a range — Select this to search devices in specific range of IP addresses.  

When this is selected, enter the IP addresses in “From” field and “To” field to specify the 
range.

- IPV4 — Select this to search for devices set with an IPv4 address.
- IPV6 — Select this to search for devices set with an IPv6 address.
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How to use the Main Window
When you access the TWAIN driver or File Downloader, the Main window for the TWAIN driver 
or File Downloader appears and lets you perform various functions more than retrieving e-Filing 
documents in the Main window.

1) Menu Bar
You can select various functions from the menu.

File menu:
- Acquire (TWAIN driver only) — Click this menu to download a document, or pages of a 

document, into an application.
- Save As (File Downloader only) — Click this menu to download pages of the selected 

document to save as a file.
- Delete — Click this menu to delete selected pages or documents.

 P.162 “Deleting e-Filing Documents”
- Properties — Click this menu to display the properties of a selected page or document.

 P.171 “Displaying the Box, Folder, Document and Page Properties”
- Automatic Download (File Downloader only) — Click this menu to configure the auto-

matic download function.
 P.163 “Setting the Automatic Download”

- Close — Click this menu to close the TWAIN driver or File Downloader Main window.

Edit menu:
- Select All — Click this menu to select all pages displayed in the Content window.  This is 

available only when you select a document in the Tree window.
- Shrink To Half — Click this menu to change resolution of the e-Filing documents to 

300x300 dpi that are originally stored in 600x600 dpi.  This feature is only available for 
the documents that are originally stored to the e-Filing by the Copy to e-Filing or Print to 
e-Filing feature.  When the check mark is displayed in this menu, all documents will be 
retrieved in 300x300 dpi.  You can cancel shrinking to half by clicking on this menu again.

 P.174 “Shrinking Documents”

View menu:
- List — Click this menu to display the List view in the Content window.
- Details — Click this menu to display the Details view in the Content window.
- Thumbnail Size — Click a desired thumbnail size from “Small”, “Medium”, and “Large”.  

This menu is only available when you display the Thumbnail view.
- Arrange Icons — Click a desired arrangement for the view from “By Name”, “By Date”, 

“By Type”, and “By Size”.
- Refresh — Click this menu to update the information in the Content window.

1

2

3

4

5

9

6 7 8
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Box Select menu:
- Device Discovery — Click this menu to add a new connection to this equipment in your 

network for the TWAIN driver and File Downloader.
 P.174 “Adding a New Device Using Network Discovery”

- Select Devices — Click this menu to change the target device when retrieving e-Filing 
documents.

 P.175 “Changing the Target Device for Retrieving e-Filing Documents”

Help
- Help — Click this menu to display Online Help.
- About — Click this menu to display the version information.

2) Tool Bar
The tool bar displays icons for performing “Delete”, “Properties”, “List”, “Details”, “Thumb-
nail”, “Refresh”, “Device Discovery”, and “Select Devices”.

3) Tree window
This displays the boxes, folders, and documents in tree view.

4) Contents windows
This displays the contents such as folders, documents, and pages of the object you select in 
the tree window.

5) Shrink to Half/Automatic Downloading
This displays whether the Shrink to Half and Automatic Downloading functions are enabled 
or disabled.  The “Automatic Downloading” will be displayed only in the File Downloader.

6) [Acquire]/[Save As]
Click this to import the selected document or pages into the TWAIN compliant application, or 
save the selected document or pages as a file.  The [Acquire] button is displayed in the 
TWAIN driver, and the [Save As] button is displayed in the File Downloader.

7) [Delete]
Click this to delete the selected documents or pages.

8) [Close]
Click this to exit the TWAIN driver or File Downloader.

9) Status Bar
This displays the communication status, number of pages or the document that you selected, 
and the IP address of the equipment to be connected.
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— Deleting e-Filing Documents
You can delete a document or page(s) in a document from e-Filing using the TWAIN driver and 
File Downloader Main window.

Deleting e-Filing documents from the Box

1 In the box tree window, browse the box where the desired docu-
ment is saved.

2 If the selected Box requires a password, the Password dialog box 
appears.  In this case, enter the 5-digit password of the Box and 
click [OK].

You can enter the administrator password instead of the 5-digit password.

3 Select the document or page(s) to be deleted.
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4 Click the [File] menu and select [Delete].

The Confirm Deletion dialog box appears.

5 Click [Yes].

The selected document or page(s) is deleted.

— Setting the Automatic Download

This feature is available only for File Downloader only.

The Automatic Download feature allows you to automatically download the documents in a 
specified box at the specified interval.
You can enable the Automatic Download by specifying the details using the Automatic Down-
load Wizard.  The documents will be deleted automatically after the documents are downloaded.

 P.164 “Starting the Automatic Download”
Once you enable the Automatic Download, it becomes impossible for you to operate other func-
tions using the File Downloader.  To operate other functions, you have to disable the Automatic 
Download.

 P.168 “Stopping the Automatic Download”
Also, you can display the summary of the Automatic Download settings when the Automatic 
Download is enabled.

 P.170 “Displaying the summary and status”
If you leave the Automatic Download setting enabled and then exit File Downloader, a dialog 
box asking you whether you want to enable the previous Automatic Download setting or not 
appears at the next startup of File Downloader.

 P.173 “Continuing the Automatic Download Setting”



4 Retrieving Documents

164    Retrieving e-Filing Documents

Starting the Automatic Download

1 Click the [File] menu and select [Start] in [Automatic Download].

The Automatic Download Wizard (1/4) dialog box appears.

2 Select the box that you want to download the documents, and enter 
the 5-digit password if the selected box is protected by a password.  
Then click [Next]

You can enter the administrator password instead of the 5-digit password.

3 If the documents that you want to download are stored in a folder, 
click [Advanced].

The Automatic Download Wizard (2/4) dialog box appears.
If you do not have to select a folder, click [Next] and skip to step 5.
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4 Select the folder that contains the documents that you want to 
download and click [Next].

The Automatic Download Wizard (3/4) dialog box appears.

5 Click [Browse].

The Browse for Folder dialog box appears.

If you previously set the Automatic Download, the folder path that you specified is dis-
played in the “Target Folder” field.  If you do not have to change the folder, you can click 
[Next] and skip to Step 8.
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6 Locate the folder that you want to save the documents, and click 
[OK].

7 Click [Next].

The Automatic Download Wizard (4/4) dialog box appears.
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8 Specify each item as you prefer.

File Format — Select the file format for saved documents.

The black and white documents are saved as the single page TIFF format if you 
select the JPEG format.
The gray scale and color mixed documents are saved as the single page TIFF format 
if you select the multi page TIFF format.
Files saved in an XPS format can be used in Windows Vista, or Windows XP SP2, 
Windows Server 2003 SP1 or later versions with XPS Essentials Pack installed.

Copy and Print Source Parameter — Select the file compression type for save 
document.  You can also enable shrinking the documents by checking the “Shrink To 
Half” check box.  This options are valid only for the documents stored by Copy to e-Filing 
or Print to e-Filing.
Polling Time Interval — Enter the polling time interval to start downloading in minutes.
Document Deletion — Check this when you want to delete documents after 
downloading.

9 Click [Next].
The Automatic Download Wizard Summary dialog box appears.

10 Confirm the settings and click [Finish].

The Automatic Download will be enabled.
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11 When you click [Finish], the File Downloader Main Window is dis-
played and disable the Tree window and Contents window.

If you want to operate other functions, disable the Automatic Download.
 P.168 “Stopping the Automatic Download”

If you want to confirm the settings and status after you enable the Automatic Down-
load, you can display the Automatic Download Summary dialog box from the Auto-
matic Download command.

 P.170 “Displaying the summary and status”

Stopping the Automatic Download

1 Click the [File] menu and select [Stop] in [Automatic Download].

The Automatic Download Result dialog box appears.
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2 Click [OK] to close the dialog box.

The Automatic Download will be disabled.

You can also display the log file by clicking [View Log File].  When you click [View Log 
File], the log file will be opened using the default text editor.
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Displaying the summary and status

Displaying the summary and status for the Automatic Download can be operated only when the 
Automatic Download is enabled.

1 Click the [File] menu and select [Summary] in [Automatic Down-
load].

The Automatic Download Summary dialog box appears.

2 Click [OK] to close the dialog box.
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You can also display the log file by clicking [View Log File].  When you click [View Log 
File], the log file will be opened using the default text editor.

— Displaying the Box, Folder, Document and Page Properties
The Box, Folder, Document, and Page Information dialog box can be displayed by selecting a 
box, folder, document or page and click [Properties] in the [File] menu.

 P.171 “Box Properties”
 P.172 “Folder Properties”
 P.172 “Document and Page Properties”

Box Properties
In the Box Information dialog box, you can see the following information about the selected box.

Contains — Number and type of contents in the box.
Size — Total size of contents in the box.
Preservation Period for Documents — The number of days to retain the document before 
deleting it automatically.
EMail Address For Notification — Email address that the notification will be sent to.
Status — “Ready” means a box is ready to edit or to be deleted.  “Busy” means a box cannot 
be modified or deleted.
Created — Date the box was created.
Modified — Date the box was previously modified.
Protected — “Yes” means this box is protected by a password.
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Folder Properties
In the Folder Information dialog box, you can see the following information about the selected 
folder.

Location — Path to the folder.
Contains — Number of documents in the folder.
Status — “Ready” means a folder is ready to edit or to be deleted.  “Busy” means a folder 
cannot be modified or deleted.
Created — Date the folder was created.
Modified — Date the folder was previously modified.

Document and Page Properties
In the Document Information or Page Information dialog box, you can see the following informa-
tion about the selected document.

Property Tab

The Property tab is only displayed for the Document Information dialog box.
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Format — How the document is saved.
Location — Path to the Box where the document is saved.
Size — Size of the document.
Total Pages — Number of pages in the document.
Status — “Ready” means a document is ready to download.  “Busy” means a document can-
not be downloaded or deleted.
Created — Date and time a document is created.
Modified — Date and time a document is previously modified.
Accessed — Date and time a document is previously accessed.

Preview Tab
The Preview tab displays the thumbnail of a selected page.  When you are displaying the docu-
ment properties, it displays the thumbnail of the fist page of the document.  The information in 
the Preview tab of the Document Information dialog box and Page Information dialog box is the 
same.

Format — How the document is saved.
Resolution — Resolution of the page.
Image Size — Pixel size of the page.
Paper Size — Paper size of the page.
Size — Data size of the page.

Continuing the Automatic Download Setting
You can select whether you continue the previous Automatic Download setting or not only when 
you have left the Automatic Download setting enabled and then exited File Downloader.

Yes — Continues the previous Automatic Download setting at the next startup of File Down-
loader.
No — Does not continue the previous Automatic Download setting at the next startup of File 
Downloader.
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— Shrinking Documents
The Shrink to Half function allows you to retrieve a 600x600dpi document as a 300x300dpi doc-
ument.  This feature is only available for the documents that are originally stored to the e-Filing 
by the Copy to e-Filing or Print to e-Filing feature. Because the Copy to e-Filing and Print to e-
Filing documents are always stored as the 600x600 dpi documents, the Shrink to Half function 
allows you to convert the 600x600 dpi documents to the 300x300 dpi for retrieval.

The Shrink to Half function reduces the resolution of the Copy to e-Filing and Print to e-Filing 
documents for retrieval.  The actual data in e-Filing will not be reduced.
The Shrink to Half function applies to only the 600x600dpi documents that were stored by 
Copy or Print operations.  This function does not apply to the documents that were stored by 
Scan or Fax operations.

Shrinking a document to half size

1 Click the [Edit] menu and select [Shrink to Half].

The check mark will be displayed in the menu.  This means the Shrink to Half function 
is enabled.  All documents will be retrieved at 300x300 dpi.
You can cancel shrinking by selecting the command again.

— Adding a New Device Using Network Discovery
You can add a new connection to other equipment by searching the equipment in your network.  
This enables you to add several devices that you can connect using the TWAIN driver and File 
Downloader.
To add a new connection, click the [Box Select] menu and select [Device Discovery].  The 
TopAccessDocMon Local Discovery dialog box appears and discovers the devices in your net-
work to add a new connection.  For further instruction on how to discover the devices using the 
TopAccessDocMon Local Discovery dialog box, see the following section.

 P.156 “When You Are Running the First Time”

After you add other devices in the connection list, you can change the target equipment by 
selecting the [Select Devices] command under the [Box Select] menu.

 P.175 “Changing the Target Device for Retrieving e-Filing Documents”
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— Changing the Target Device for Retrieving e-Filing Documents
If you have added more than one device to connect, you can change the target device for 
retrieving e-Filing documents using the TWAIN driver and File Downloader.

Selecting the target device for retrieving e-Filing documents

1 Click the [Box Select] menu and select [Select Devices].

The Select Device dialog box appears.

2 Select the name of the equipment that you want to connect to, and 
click [OK].

The target device has been changed to the selected equipment.
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Safeguarding Data

An administrator should monitor the volume data in the e-Filing periodically to make sure there is 
enough hard disk space for the operations.  This section describes the administrator’s function 
that allows you to delete boxes.

Erasing Box Data
You can manually erase boxes in the e-Filing if the data has been corrupted—for example, by a 
hard disk failure—and is therefore no longer usable.

Erasing the box data

1 Log on to the Administrator page.
 P.53 “Logging On the Administrator Page”
The Erase Box page is displayed.

It is recommended to archive the documents in the boxes before deleting the boxes.  
Once the boxes are deleted, you cannot restore the documents in the boxes.

 P.90 “Archiving Documents”

You can display the Box Properties window by clicking the box number or box name 
links.

2 Mark the check boxes of user boxes that you want to delete and 
click [OK].

* Please note that the screen may be slightly different depending on the system you are using.
The confirmation dialog box appears.

For more information about the Erase Box Subtab page, see the following section.
 P.57 “Erase Box Subtab”
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3 Click [OK].

The selected user boxes are deleted from the e-Filing.
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Using e-Filing Backup/Restore Utility

The Client Utilities CD-ROM includes the e-Filing Backup/Restore Utility. You can use these util-
ities to set the e-Filing and to backup or restore the image data in it for the e-STUDIO451c 
Series, e-STUDIO850 Series, e-STUDIO853 Series, e-STUDIO452 Series, e-STUDIO453 
Series, e-STUDIO282 Series or e-STUDIO283 Series.

Installing e-Filing Backup/Restore Utility
You can install e-Filing Backup/Restore Utility from Client Utilities CD-ROM.

System Requirements
The e-Filing Backup/Restore Utility is available for following environments:

Display Resolution
1024 x 768 dots or more
Display Color
High Color (16bit) or higher is recommended
CPU
Pentium 133 MHz minimum (Pentium 266 MHz or faster recommended)
OS
Windows 2000 Service Pack 4
Windows XP Service Pack 1
Windows Vista
Windows Server 2003 Service Pack 1
Required Software
Microsoft Internet Explorer 5.5 Service Pack 2 or later must be installed (for the IPv4 only)
Microsoft Internet Explorer 7.0 or later must be installed (for the IPv6 only)
Microsoft Internet Explorer is enabled to access the e-Filing web utility on this equipment.
- The proxy settings must be configured correctly to enable the access.
- The browser must not be offline.

To backup/restore e-Filing data using e-Filing Backup/Restore Utility, the FTP Server option that 
can be set in the Network settings of TopAccess must be enabled.

Installing e-Filing Backup/Restore Utility

This procedure describes an installation on Windows XP.  The procedure is the same when 
other versions of Windows are used.

You must log into Windows as a user who has the “Administrators” privilege, when using the 
Windows NT 4.0, Windows 2000, Windows XP, or Windows Server 2003.
When using Windows Vista, you can install by entering the Administrator password at the 
time of starting the installer, although you have not logged in as a user with Administrator 
privilege.

1 Insert the Client Utilities CD-ROM into the CD-ROM drive.

2 Click [Exit] to close the Choose Setup Language dialog box when 
the installer automatically starts.

3 Open “Admin\e-FilingUtility” folder and double-click “setup.exe”.
The Choose Setup Language dialog box appears.
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4 Click [Next].

5 Select your language and click [OK].

The InstallSheild Wizard dialog box appears.

6 Select “I accept the terms of the license agreement” and click 
[Next].

The Choose Destination Location screen is displayed.
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7 Click [Next].

If you want to change where the programs are installed, click [Change...].  In the dia-
log box appears, select the folder and click [OK].
The Select Program Folder screen is displayed.

8 Click [Install].

If you want to change the program folder, rename the folder in the “Program Folder” 
field.
Starts copying files and the InstallShield Wizard Complete screen is displayed when 
copying is completed.

9 Click [Finish].

The installation is completed.
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The Installer may ask you to restart your computer.  If it does, select “Yes, I want to 
restart my computer now.” and click [Finish] to restart your computer.

Uninstalling the Backup/Restore Utility
The following describes how to uninstall the Backup/Restore Utility.

Uninstalling the Backup/Restore Utility

The following describes an uninstallation on Windows XP.  The procedure is the same when 
other versions of Windows are used.

1 Open “Control Panel” and double-click the “Add or Remove Pro-
grams” icon.

The Add/Remove Programs dialog box appears.
When using Windows Vista, select [Start],  [Control] select [Program] and uninstall the 
program.
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2 Select “TOSHIBA e-STUDIO Back Up-Restore Utility” and click 
[Remove].

3 Click [Yes].

How to use e-Filing Backup/Restore Utility
The e-Filing Backup/Restore Utility allows you to create a backup file for e-Filing data from the 
equipment and restore e-Filing data from a backup file into the equipment.

Running e-Filing Backup/Restore Utility
After installing the e-Filing Backup/Restore Utility, the program icon will be added in the 
“TOSHIBA e-STUDIO Client” folder within the “Programs” folder in the Start menu.

Running e-Filing Backup/Restore Utility

1 Click the [Start] menu, select [Programs], and click [TOSHIBA e-
STUDIO BackUp-Restore] in the [TOSHIBA e-STUDIO Client] pro-
gram folder.

The e-STUDIO e-Filing Backup/Restore Utility Login dialog box appears.

When you are running the first time and the connection to the equipment has not been 
configured, the TopAccessDocMon Local Discovery dialog box appears.  If this dialog 
box appears, configure the connection to the equipment.

 P.185 “When You Are Running the First Time”
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2 Enter the administrator’s password and click [OK].

3 The e-Filing Backup/Restore Utility main window appears.

— When You Are Running the First Time
When you access the e-Filing Backup/Restore Utility the first time, the TopAccessDocMon Local 
Discovery dialog box appears.  In this case, search the equipment in your network and configure 
the connection.

You can also change a target device to backup or restore e-Filing data.  To do this, you must add 
an additional connection to the other equipment using the Local Discovery function.

 P.199 “Adding a New Device Using Local Discovery”
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Discovering the device automatically

1 In the TopAccessDocMon Local Discovery dialog box, click [Start 
Discovery] to begin the process.

It locates all the compatible devices in your network.

2 When the process is completed, found devices are listed in the list.

If the process continues for a long time, it is because too many network clients are on the 
network.  In that case, you can configure the discovery using the [Advanced] button.

 P.188 “Configuring Discovery Settings”

3 Select the equipment that you want to connect from the list and 
click [OK].

The e-STUDIO e-Filing Backup/Restore Utility Login dialog box appears.
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Discovering the device manually

1 In the TopAccessDocMon Local Discovery dialog box, click [Manual 
Selection].

The Manual Selection dialog box appears.

2 Enter each item to specify the network address of the device and 
click [OK].

IP Address — Enter the IP address of the printer.
IPX Address — This is disabled because the e-Filing Backup/Restore Utility does not 
support the IPX/SPX connection.
Name — Enter the printer name.
Location — Enter the location of the printer.

You must enter “Name” and “IP Address”.
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3 The entered printer is added in the list.  Select the printers that you 
want to monitor from the list and click [OK].

The e-STUDIO e-Filing Backup/Restore Utility Login dialog box appears.

Configuring Discovery Settings
You can configure the discovery settings.

1) Devices
Click the arrow button to display the poll down list and check the model name that you want 
to search.

This software can backup or restore the data only from the e-STUDIO3510c Series, 
e-STUDIO451c Series, e-STUDIO850 Series, e-STUDIO853 Series, e-STUDIO452 Series, 
e-STUDIO453 Series, e-STUDIO282 Series, e-STUDIO283 Series, e-STUDIO4511 Series, 
e-STUDIO350 Series, e-STUDIO280 Series

2) Network - Enable IPX/SPX Search
This is disabled because the e-Filing Backup/Restore Utility does not support the IPX/SPX 
connection.
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3) Network - Enable TCP/IP Search
Select this to search for devices connected to the TCP/IP network.  This is available only 
when the TCP/IP protocol is installed.
When this is enabled, select how it searches devices in the TCP/IP network.
- Search local subnet — Select this to search devices in local subnet.
- Specify a range — Select this to search devices in specific range of IP addresses.  

When this is selected, enter the IP addresses in “From” field and “To” field to specify the 
range.

- IPV4 — Select this to search for devices set with an IPv4 address.
- IPV6 — Select this to search for devices set with an IPv6 address.

How to use the Main Window
When you access the e-Filing Backup/Restore Utility, the Main window for the e-Filing Backup/
Restore Utility appears and lets you perform various functions.

1) Menu Bar
You can select various functions from the menu.

File menu:
- Backup Data — Click this menu to display the Backup tab.  This is available only when 

displaying the [Restore] tab.
- Restore Data — Click this menu to display the Restore tab.  This is available only when 

displaying the [Backup] tab.
- Automatic Backup — Click this menu to configure the automatic backup function.  This 

is available only when displaying the [Backup] tab.
 P.193 “Backing Up e-Filing Data Automatically”

- Exit — Click this menu to close the e-Filing Backup/Restore Utility Main window.

Edit menu:
- Select All — Click this menu to check all checkboxes of the e-Filing boxes displayed in 

the Contents window.
- Clear All — Click this menu to clear all checkboxes of the e-Filing boxes displayed in the 

Contents window.

View menu:
- Refresh — Click this menu to update the information in the Content window.

1

2

3

4

5

7

6

8
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Devices menu:
- Device Discovery — Click this menu to add a new connection to this equipment in your 

network for the e-Filing Backup/Restore Utility.
 P.199 “Adding a New Device Using Local Discovery”

- Select e-STUDIO — Click this menu to change the target device to backup or restore e-
Filing data.

 P.199 “Changing the Target Device”
- Initialize e-Filing storage — Click this menu to initialize the e-Filing boxes before restor-

ing e-Filing data.  This is available only when displaying the [Restore] tab.
 P.198 “Initializing e-Filing Storage”

Help
- Help — Click this menu to display Online Help.
- About — Click this menu to display the version information.

2) Backup/Restore tabs
Click the [Backup] tab to operate backing up e-Filing data.  Click the [Restore] tab to operate 
restoring e-Filing data.

3) Target File
When the [Backup] tab is displayed, enter the backup file name.
When the [Restore] tab is displayed, enter the restore file name.

4) Backup Type Setting/Backup Property
When the [Backup] tab is displayed, the Backup Type Setting is displayed.  In the Backup 
Type Setting, select how this backs up the data.
- Full Backup—Backup the all data in the selected boxes.
- Incremental Backup—Backup only the updated data since the last backup.

When the [Restore] tab is displayed, the Backup Property of the backup data that you spec-
ify in the Target File field.

5) Contents windows
When the [Backup] tab is displayed, this displays the boxes that the target equipment 
includes.
When the [Restore] tab is displayed, this displays the boxes that the selected restore file 
includes.

6) [Backup]/[Restore]
When the [Backup] tab is displayed, the [Backup] button will be displayed. Click this to 
backup e-Filing data from the equipment.

 P.190 “Backing Up e-Filing Data Manually”
When the [Restore] tab is displayed, the [Restore] button will be displayed.  Click this to 
restore e-Filing data into the equipment.

 P.196 “Restoring e-Filing Data”

7) IP  address
This displays the IP address of equipment.

8) Status Bar
This displays the status of equipment and communication status to the equipment.

— Backing Up e-Filing Data Manually
To backup e-Filing data from the equipment, perform the following operation.
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Please make sure that the backup data does not exceed 4GB.
Backing up cannot be performed while any users access e-Filing boxes using e-Filing web 
utility or Touch Panel Display, or any jobs are currently processed in the equipment.  Please 
make sure no user access e-Filing boxes before backing up e-Filing data, and no jobs are 
processed in the equipment.
While backing up the e-Filing data, any operations using the Touch Panel Display will be dis-
abled.  Also TopAccess and e-Filing web utility will be disabled.
While backing up the e-Filing data, any print jobs, N/W-Fax jobs, and received faxes are held 
in the equipment until backing up completes.
Backing up the e-Filing data may take few hours.  Therefore, if the equipment receives many 
print jobs, N/W-Fax jobs, received faxes while backing up the e-Filing data, Job Full error 
may occur.

You can also configure the schedule so that backing up e-Filing data can be performed automat-
ically.

 P.193 “Backing Up e-Filing Data Automatically”

Backing up e-Filing Data Manually

1 Click [Browse] in the [Backup] tab.

The Open dialog box appears.

You can also enter the path to save a backup file directly in the “Target File” field.  
However, a backup file cannot be saved when you specify the path using an IP 
address.  When you want to specify a network folder, enter the network without using 
an IP address.
The backup file must saved as a ZIP file.  You cannot save it in another format.  More-
over, you must specify the “.zip” extension for the file name to enable the [Backup] 
button.
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2 Locate the folder that you want to save a backup file, change the 
file name as you require, and click [Open].

3 Select the backup type.

Full Backup—Backup the all data in the selected boxes.
Incremental Backup—Backup only the updated data since the last backup.

If you connect to the e-STUDIO4511 Series, e-STUDIO450 Series, or e-STUDIO280 
Series, you cannot specify the backup type.

4 Check the boxes that you want to backup, and click [Backup].

It starts backing up e-Filing data.  When backing up e-Filing data is completed, the 
Backup Information dialog box appears.
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Please make sure that the hard disk space for saving a backup file is available in your 
computer.  The size of a backup file may become the same size of the e-Filing box disk 
space.

5 Click [OK].

— Backing Up e-Filing Data Automatically
Using Automatic Backup function, you can configure the schedule to backup e-Filing data.

Please make sure that the backup data does not exceed 4GB.
Backing up cannot be performed while any users access e-Filing boxes using e-Filing web 
utility or Touch Panel Display.  Please make sure no user access e-Filing boxes before back-
ing up e-Filing data.
While backing up the e-Filing data, any operations using the Touch Panel Display will be dis-
abled.  Also TopAccess and e-Filing web utility will be disabled.
While backing up the e-Filing data, any print jobs, N/W-Fax jobs, and received faxes are held 
in the equipment until backing up completes.
Backing up the e-Filing data may take few hours.  Therefore, if the equipment receives many 
print jobs, N/W-Fax jobs, received faxes while backing up the e-Filing data, Job Full error 
may occur.

Backing up e-Filing Data Automatically

1 Click [Browse] in the [Backup] tab.

The Open dialog box appears.
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You can also enter the path to save a backup file directly in the “Target File” field.  
However, a backup file cannot be saved when you specify the path using an IP 
address.  When you want to specify a network folder, enter the network without using 
an IP address.
The backup file must saved as a ZIP file.  You cannot save it in another format.  More-
over, you must specify the “.zip” extension for the file name to enable the [Automatic 
Backup] command in the [File] menu.

2 Locate the folder that you want to save a backup file, change the 
file name as you require, and click [Open].

3 Select the backup type.

Full Backup—Backup the all data in the selected boxes.
Incremental Backup—Backup only the updated data since the last backup.

If you connect to the e-STUDIO4511 Series, e-STUDIO450 Series, or e-STUDIO280 
Series, you cannot specify the backup type.
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4 Check the boxes that you want to backup automatically.  Then click 
the [File] menu and select [Automatic Backup].

The Automatic Backup dialog box appears.

5 Specify each item and click [Set].

Start Date and Time — Specify the date and time to start backing up e-Filing data 
automatically.  You cannot specify the date of more than six months after.
Repeat Interval — Select the interval to apply the automatic backup from “OnlyOnce”, 
“Daily”, “Weekly”, or “Monthly”.
Setting — Select whether the automatic backup will be performed when any of selected 
boxes have been deleted.
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6 The automatic backup is enabled and disable the main window.

When you want to cancel the automatic backup, click [Cancel Schedule] to select [Exit] in 
the [File] menu.

— Restoring e-Filing Data
To restore e-Filing data to the equipment, perform the following operation.

Restoring cannot be performed while any users access e-Filing boxes using e-Filing web 
utility or Touch Panel Display, or any jobs are currently processed in the equipment.  Please 
make sure no user access e-Filing boxes before restoring e-Filing data, and no jobs are pro-
cessed in the equipment.
While restoring the e-Filing data, any operations using the Touch Panel Display will be dis-
abled.  Also TopAccess and e-Filing web utility will be disabled.
While restoring the e-Filing data, any print jobs, N/W-Fax jobs, and received faxes are held in 
the equipment until restoring completes.
Restoring the e-Filing data may take few hours.  Therefore, if the equipment receives many 
print jobs, N/W-Fax jobs, received faxes while restoring the e-Filing data, Job Full error may 
occur.

When you want to delete all e-Filing data in the equipment and restore e-Filing data from the 
backup file, initialize e-Filing storage before restoring data.

 P.198 “Initializing e-Filing Storage”
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Restoring e-Filing data

1 Click the [Restore] tab and click [Browse].

The Open dialog box appears.

2 Select a backup file that you want to restore, and click [Open].
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3 Check the boxes that you want to restore and click [Restore].

The Restore Mode Setting dialog box appears.

4 Select whether overwriting documents with the backup data, and 
click [OK].

It starts restoring e-Filing data.  When restoring e-Filing data is completed, the 
Restore Information dialog box appears.

When the same box number exists in the equipment, the box properties, such as a box 
name and password setting, cannot be restored from the backup file.

5 Click [OK].

— Initializing e-Filing Storage
When you want to delete all e-Filing data in the equipment before restoring, perform the follow-
ing operation.

Initializing e-Filing storage cannot be performed while any users access e-Filing boxes using e-
Filing web utility or Touch Panel Display, or any jobs are currently processed in the equipment.  
Please make sure no user access e-Filing boxes before initializing e-Filing data, and no jobs are 
processed in the equipment.
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Initializing e-Filing storage

1 Click the [Restore] tab and select [Initialize e-Filing storage] in the 
[Devices] menu.

The Confirm Initialize dialog box appears.

2 Click [Yes].

It start initializing e-Filing storage and all e-Filing data will be deleted.

— Adding a New Device Using Local Discovery
You can add a new connection to other equipment by searching the equipment in your network.  
This enables you to add several devices that you can connect using the e-Filing Backup/Restore 
Utility.
To add a new connection, click the [Devices] menu and select [Device Discovery].  The TopAc-
cessDocMon Local Discovery dialog box appears and discovers the devices in your network to 
add a new connection.  For further instruction on how to discover the devices using the TopAc-
cessDocMon Local Discovery dialog box, see the following section.

 P.185 “When You Are Running the First Time”

After you add other devices in the connection list, you can change the target equipment by 
selecting the [Select e-STUDIO] command under the [Box Select] menu.

 P.199 “Changing the Target Device”

— Changing the Target Device
If you have added more than one device to connect, you can change the target device for back-
ing up or restoring e-Filing data using e-Filing Backup/Restore Utility.
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Selecting the target device

1 Click the [Devices] menu and select [Select e-STUDIO].

The Select Device dialog box appears.

2 Select the name of the equipment that you want to connect to, and 
click [OK].

The target device has been changed to the selected equipment.
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File Menu Functions

You can find the New Box, New Folder, Open, Rename, Archive Document, Upload Archive 
Document, Test Print, Print Document, and Properties functions under the File menu.

 P.202 “New Box”
 P.203 “New Folder”
 P.203 “Open”
 P.203 “Rename”
 P.204 “Archive Document”
 P.205 “Upload Archived Document”
 P.206 “Test Print”
 P.207 “Print Document”
 P.214 “Properties”
 P.218 “Page Properties”
 P.219 “Send Email”

New Box
You can create new user boxes in e-Filing, using this function.
When you select the New Box function from the File menu, the New Box window appears.

1) Box Number
Select the 3-digit box number.  In the Box Number drop down box, only undefined box num-
bers are displayed.

2) Box Name
Enter the box name to be created.  You can enter any ASCII characters except: \ / < > " % & 
= ' ; : * ? | and #. Do not use a space or period at the beginning or end of the name. The max-
imum size of a box name is 32 characters.

3) Box Password
Enter the 5-digit box password if you want to protect the box with a password.  Leave this 
field blank if you do not want password protection.

4) Confirm Password
Enter the 5-digit box password if you want to protect the box with a password.

5) [OK]
Click this to create new user box.
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6) [Cancel]
Click this to cancel creating new user box.

New Folder
You can create a new folder in selected box using this function.
The New Folder function is only enabled when you select a box from the Documents frame. If 
you don’t select a folder, the New Folder option is grayed out.
When you select the New Folder function from the File menu, the New Folder window appears.

1) Name
Enter the folder name to be created.  You can enter any ASCII characters except: \ / < > " % 
& = ' ; : * ? | and #. Do not use a space or period at the beginning or end of the name. The 
maximum size of a folder name is 64 characters.

2) [OK]
Click this to create a new folder.

3) [Cancel]
Click this to cancel creating a new folder.

Open
You can open select box, folder, or document using this function.
The Open function is enabled when you select a box, folder, or document in the Contents frame. 
When you select Open from the File menu, the selected box, folder, or document opens in the 
Documents frame and you can see the contents in the Contents frame.

Rename
You can rename the box name, folder name, or document name using this function.
The Rename function is only enabled when you select a user box, folder, or document in the 
Documents frame. If you do not select a user box, folder or document, the Rename option is 
grayed out.
When you select Rename from the File menu, the Rename window appears.

1) Name
Enter the box, folder, or document name.
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2) [OK]
Click this to apply modified name.

3) [Cancel]
Click this to cancel renaming.

Archive Document
You can create an archived file that contains selected documents.  The created archive file can 
be used to upload the documents at a later time, or to upload the documents to other 
e-STUDIO451c Series, e-STUDIO850 Series, e-STUDIO853 Series, e-STUDIO452 Series, e-
STUDIO453 Series, e-STUDIO282 Series or e-STUDIO283 Series.
The Archive Document function is enabled when you select documents in the Contents frame.  If 
you do not select documents, the message “Please select at least one item.” will be displayed.
When you select Archive Document from the File menu, the confirmation dialog box appears.

When you click [OK] in the confirmation dialog box, the Archive Document window will appear 
and display the process of archiving the documents.  During the process, you can click [Cancel] 
to quit archiving and close the window.

When the archive process is completed, the window will display the successful message and the 
link to download the archived file.  You can click the archived file link to download the archive file 
to your computer. When you click [Close] in the window, the archived file is deleted from the 
hard disk on this equipment and the window will close.
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Upload Archived Document
You can upload the archived file previously created using the Archive Document function.  When 
you upload the archived file, documents compressed in the archived file are added to the 
selected box.
The Upload Archived Document function is enabled when you select a box in the Documents 
frame.  If you do not select a box, the Upload Archived Document option is grayed out.
When you select Upload Archived Document from the File menu, the Upload Archived Docu-
ment window will appear.

1) Archive File
Enter the path to the archive file, or click [Browse] to select the archive file.

2) [OK]
Click this to upload selected archive file.

3) [Cancel]
Click this to cancel uploading an archive file.

After you click [OK] in the Upload Archived Document window, the confirmation dialog box 
appears.

When you click [OK] in the confirmation dialog box, the Upload Archived Document window 
appears and displays the process of uploading the archived file.  During the process, you can 
click [Cancel] to quit uploading and close the window.

When it completes the upload process, the window displays the successful message.  Then 
click [Cancel] to close the window.
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Test Print

You can print one copy of selected document with default print settings using this function.
The Test Print function is enabled when you select document in the Documents frame.  If you do 
not select a document, the message “Please select a document.” will be displayed.
When you select Test Print from the File menu, the Test Print window appears.

When the User Management Setting is enabled, the maximum number of copies that is allowed 
for the department and user will be displayed in the upper right of the page.

1) All Pages
Select this to print all pages of the document.

2) [first page number]-[last page number] Pages
Select this to specify the pages to be printed.  Enter the first-of-page and end-of-page num-
ber to be printed in each field.

3) Department Code
Enter the 5-digit department code.  This must be enter only when the department code is 
enabled on the equipment.

4) [Print]
Click this to print one copy of the document.

5) [Cancel]
Click this to cancel printing.

After clicking [Print] in the Test Print window, the window displays the successful message.
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Print Document
You can print selected document with specified print settings using this function.
The Print Document function is enabled when you select a document in the Documents frame.  
If you do not select a document, the message “Please select a document.” will be displayed.
When you select Print Document from the File menu, the Print window appears.

When the User Management Setting is enabled, the maximum number of copies that is allowed 
for the department and user will be displayed in the upper right of the page.

1) Duplex
Select whether the document is printed on both sides of the paper or not.
- None — Select this if you do not want to print both side of paper.
- Book — Select this to print both sides of the paper which will be bound along the vertical 

side of the paper so that the pages can be turned over right and left.
- Tablet — Select this to print both sides of the paper with a vertical reversal to be bound 

along the horizontal side of the paper so that the pages can be turned over up and down.

2) Number of Copies
Enter the number of printed copies.  You can set any integer from 1 to 999.

3) Sort Copies
Select this for sort-printing (1, 2, 3... 1, 2, 3...).
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4) Group Copies
Select this for group-printing (1, 1, 1... 2, 2, 2... 3, 3, 3...).

5) Rotate Sort Copies
Select this for alternate-printing.

When the Rotate Sort Copies option is enabled, the printed copies are output in the inner 
tray.

6) Paper Type
Select the media type of the paper.
- Plain — Select this when printing on 20-24 lbs plain paper (64-80 g/m2 plain paper).
- Thick1 — Select this when printing on 24-28 lbs thick paper (81-105 g/m2 thick paper).
- Thick2 — Select this when printing on 32-90 lbs thick paper (106-163 g/m2 thick paper).
- Thick3 — Select this when printing on 110 lbs thick paper (164-209 g/m2 thick paper).
- Transparency — Select this when printing on transparent sheets. 

For more information about the paper types that are available for this equipment, please 
refer to Operator’s Manual for Basic Functions.

7) Department Code
Enter the user’s department code (This depends on whether this equipment is managed with 
department code or not).  Please ask your administrator for your department code.

8) Paper Source
This selects the source for feeding paper. Please select a paper source that correlates with 
the printing size.
- Auto Select — Automatically selects the paper set in this equipment according to the 

printed document size.  When other than “Plain” or “Thick1” is selected in the Paper Type 
option, paper is fed from the Bypass Tray.

- Drawer 1 — Paper is fed from the Drawer 1.
- Drawer 2 — Paper is fed from the Drawer 2.
- Drawer 3 — Paper is fed from the Drawer 3.  This cannot be selected if Drawer 3 is not 

installed.
- Drawer 4 — Paper is fed from the Drawer 4.  This cannot be selected if Drawer 4 is not 

installed.
- LCF*1 — Paper is fed from the Large Capacity Feeder.  This cannot be selected if the 

Large Capacity Feeder is not installed.
- Tandem LCF*2 — Paper is fed from the Tandem Large Capacity Feeder.  This cannot be 

selected if the Tandem Large Capacity Feeder is not installed.
- External Large Capacity Feeder*2 — Paper is fed from the External Large Capacity 

Feeder.  This cannot be selected if the External Large Capacity Feeder is not installed.
- Bypass Tray — Paper is fed from the Bypass Tray.

*1 Only applicable to the e-STUDIO281c/351c/451c, e-STUDIO352/452, e-STUDIO353/453, e-
STUDIO202L/232/282 and e-STUDIO203L/233/283.

*2 Only applicable to the e-STUDIO520/600/720/850 and e-STUDIO523/603/723/853.

The selectable values vary depending on the optional devices installed on this equipment.
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9) Destination
Select the destination tray to be output.
- Inner Tray — Select this to route the output to the inner tray.
- Tray 1 — Select this to route the output to the upper tray of the Finisher.
- Tray 2 — Select this to route the output to the lower tray of the Finisher.

“Tray 1” and “Tray 2” are only available when the Hanging Finisher, Multi-staple Finisher or 
Saddle Stitch Finisher are installed.

10)Staple
This sets whether a document is printed with staples.
- None — Select this to print without staples.
- Upper Left — Select this to staple in the upper left and print.
- Lower Left — Select this to staple in the lower left and print.
- Upper Right — Select this to staple in the upper right and print.
- Middle Left (Double) — Select this to staple double in the left and print.
- Center Top (Double) — Select this to staple double in the upper side and print.
- Staple Down The Center — Select this to staple double in the center and print.

This option is grayed out when no finisher is installed.
“Staple Down The Center” can be selected only when the Saddle Stitch Finisher is 
installed.
If you enable the Staple option after enabling the Interleave Pages option, the Interleave 
Pages option will be automatically disabled.

11) Hole Punch
Select whether a document is printed with hole punches.
- None — Select this to print without hole punches.
- Center Top — Select this to create holes on the upper side and print.
- Middle Left — Select this to create holes on the left side and print.

This option is grayed out if a hole punch unit is not installed.

12)Page Number
This sets where the page number is printed.

Position
Select the position the page number will be printed.

Initial Page
Enter the page number starts with, between 1 to 999.

13)Time Stamp
This sets where the time stamp is printed.

Position
Select the position the time stamp will be printed.

14) Image Shift
This sets whether the page image is shifted or not.

Position
Select the direction the image will be shifted.
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Shift Margin
- Front — Specify the width of margin added to the front page.
- Back — Specify the width of margin added to the back page.  This applies only when 

enabling the duplex printing.

15)Use Front Cover
This sets front cover printing which allows you to insert or print a cover on a sheet fed from a 
different tray than the Paper Source option.
To enable cover printing, check on the box and select the location from where a cover sheet 
is to be fed and the print style to be used.

Source
Select the location from where a cover sheet is to be fed.  When “Auto” is selected, the paper 
is automatically selected according to the printed document size.

When selecting the Bypass Tray in the Source drop down box, the message “Press JOB 
STATUS button” will be displayed in the touch panel.  When pressing the [JOB STATUS] 
button, the message “Place Paper in the Bypass tray  Press the START button” will be 
displayed.  Then place the paper in the Bypass tray and press the [START] button.
The selectable values in the Source drop down box vary depending on the optional 
devices installed on this equipment.

Print Style
This selects how you want to print a cover.
- Do not print on page — Select this to insert a blank cover.
- Print on 1 side of page — Select this to print the first page image on the front side of a 

cover.
- Print on both sides of page — Select this to print the first two page images on both 

sides of a cover. This is available only when the Duplex option is set to either “Book” or 
“Tablet”

If “Print on 1 side of page” is selected while the Duplex option is set to either “Book” or “Tab-
let”, the first page is printed on the front side of the cover sheet and the back side of the 
cover will be blank.

16)Use Back Cover
This sets back cover printing which allows you to insert or print a back cover on a sheet fed 
from a different tray than the Paper Source option.
To enable back cover printing, check on the box and select the location from where a back 
cover sheet is to be fed and the print style to be used.  

Source
Select the location from where a back cover sheet is to be fed.  When “Auto” is selected, the 
paper is automatically selected according to the printed document size.

When selecting the Bypass Tray in the Source drop down box, the message “Press JOB 
STATUS button” will be displayed in the touch panel.  When pressing the [JOB STATUS] 
button, the message “Place Paper in the Bypass tray  Press the START button” will be 
displayed.  Then place the paper in the Bypass tray and press the [START] button.
The selectable values in the Source drop down box vary depending on the optional 
devices installed on this equipment.
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Print Style
This selects how you want to print a back cover.
- Do not print on page — Select this to insert a blank cover.
- Print on 1 side of page — Select this to print the last page image on the front side of a 

cover.
- Print on both sides of page — Select this to print the last two page images on both 

sides of a cover. This is available only when the Duplex option is set to either “Book” or 
“Tablet”

If “Print on 1 side of page” is selected while the Duplex option is set to either “Book” or 
“Tablet”, the last page is printed on the front side of the cover sheet and back side of the 
cover will be blank.
If “Print on both sides of page” is selected but there is only one page printed on the back 
cover, the last page is printed on the front side of the cover sheet and back side of the 
cover will be blank.

17) Insert Page
This sets sheet insertion printing which allows you to insert a sheet between pages, or print a 
specific page on a sheet fed from a tray other than the Paper Source option.
This option is useful when you want to insert a blank sheet between chapters, or when you 
want to print chapter cover pages on the different paper.
To enable sheet insertion printing, check on the box and select the location from where 
inserted sheets are to be fed and the print style to be used.  Then, enter the page number 
you want to insert in the Pages field.

Source
Select the location from where insertion sheets are to be fed.  When “Auto” is selected, the 
paper is automatically selected according to the printed document size.

When selecting the Bypass Tray in the Source drop down box, the message “Press JOB 
STATUS button” will be displayed in the touch panel.  When pressing the [JOB STATUS] 
button, the message “Place Paper in the Bypass tray  Press the START button” will be 
displayed.  Then place the paper in the Bypass tray and press the [START] button.
The selectable values in the Source drop down box vary depending on the optional 
devices installed on this equipment.

Print Style
This selects how you want to print on insertion sheets.
- Do not print on page — Select this to insert blank sheets.
- Print on 1 side of page — Select this to print the specified pages on the front side of the 

insertion sheets.
- Print on both sides of page — Select this to print the specified pages on both sides of 

the insertion sheets. This is available only when the Duplex option is set to either “Book” 
or “Tablet”.
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Pages
Enter the page number where the sheet is to be inserted.  To enter multiple pages, separate 
page numbers with commas.
When “Do not print on page” is selected from the Print Style drop down box, the blank sheet 
is inserted before the entered pages.
When “Print on 1 side of page” is selected from the Print Style drop down box, entered page 
will be printed on the inserted sheet.
When “Print on both sides of page” is selected from the Print Style drop down box, entered 
page and the next page will be printed on both sides of the inserted sheet.

If “Do not print on page” is selected while the Duplex option is set to either “Book” or 
“Tablet”, and you enter an even numbered page (printed on the back side of the paper) 
for the Pages field, the specified page will be blank.  The desired blank sheet is inserted 
next and the 2-sided printing continues from the next page.

If “Print on 1 side of page” is selected while the Duplex option is set to either “Book” or 
“Tablet”,  the specified page is printed on the front side of the sheet and back side of the 
sheet will be blank.

If “Print on 1 side of page” is selected while the Duplex option is set to either “Book” or 
“Tablet”, and you enter an even numbered page (printed on the back side of the paper) 
for the Pages field, the specified page will be blank. The page is printed on the front side 
of the inserted sheet and the 2-sided printing continues from the next page.

If “Print on both sides of page” is selected while the Duplex option is set to either “Book” 
or “Tablet”, and you enter an even numbered page (printed on the back side of the paper) 
for the Pages field, the specified page will be blank. The specified page and the next 
page are printed on the inserted sheet and the 2-sided printing continues from the next 
page.
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18) Interleave Pages
This sets the interleaving page feature that is useful when you want to insert paper of a dif-
ferent type (or from another source) between every page of your print job. For example, you 
could use this option to insert blank, colored sheets between overhead transparencies.
To enable interleaving pages, check on the box and select the location from where sheets 
are to be fed.

If you enable the Interleave option after enabling the Staple option, the Staple option will be 
automatically disabled.

Source
Select the location from where the interleaving sheet is to be fed.  When “Auto” is selected, 
the paper is automatically selected according to the printed document size.

When selecting the Bypass Tray in the Source drop down box, the message “Press JOB 
STATUS button” will be displayed in the touch panel.  When pressing the [JOB STATUS] 
button, the message “Place Paper in the Bypass tray  Press the START button” will be 
displayed.  Then place the paper in the Bypass tray and press the [START] button.
The selectable values in the Source drop down box vary depending on the optional 
devices installed on this equipment.

Duplicate
When you check on this, you can print previous page images on the inserted sheet.

19)Paper Type (Insert)
When you select “Bypass Tray” for the paper source of either the “Use Front Cover”, “User 
Back Cover”, “Insert Pages”, or “Interleave Pages” option, select the paper type for the paper 
fed from the Bypass Tray.

20)Scheduled Print
Check this to print a job at a future date and time.  When this is selected, set the date and 
time to print a job in the “Date & Time” option.

21) [Print]
Click this to print the document.

22) [Cancel]
Click this to cancel printing.

23) [Reset]
Click this to restore the default settings.

After clicking [Print] in the Print window, the window displays the successful message.
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Properties
You can display the properties of a box, folder, and document using this function.
The Properties function is enabled when you select a box, folder, or document in the Documents 
frame.

 P.214 “Box Properties”
 P.216 “Folder Properties”
 P.217 “Document Properties”

Box Properties
If you select a box within the Documents frame and, then, select File and Properties, the Box 
Properties window will appear.
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When you display the Box Properties window, you can click [Change Properties] to modify the 
box properties.  If you click [Change Properties] in the Box Properties window, the Change Box 
Properties window will appear.

1) Change Box Password
Check this box to change a box password.  When you check this option, enter the “Old Box 
Password”, “New Box Password”, and “Confirm New Password”.

2) Old Box Password
Enter the current box password.  If you forget the old box password, you can enter the 
administrator password instead of the old box password.

3) New Box Password
Enter new box password.

4) Confirm New Password
Enter new box password again.

5) Delete document automatically
Check this to automatically delete a document in the box.  When you check this, enter the 
number of days the documents are to remain in the “Preservation Period for Documents” 
field.

6) Preservation Period for Documents
Enter the number of days the documents are to remain in the box, if you check the “Delete 
document automatically” check box.  When this function is enabled, the document will be 
deleted after the specific days have been passed.

7) Send email when an error occurs
Check this to send a notification message to the specified Email address when an error 
occurs.  When you check this, enter an Email address in the “Email Address” field.
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8) Send email when job is completed
Check this to send a notification message to the specified Email address when a job is com-
pleted.  When you check this, enter an Email address in the “Email Address” field.

9) Advanced automatic delete notification
Check this to enable the Email notification, which will send a notification message to the 
specified Email address 3 days before it automatically deletes the documents.  When you 
check this, enter an Email address in the “Email Address” field.

10)Email Address
Enter the Email address to which the notification message will be sent.

11) [Save]
Click this to save the box properties.

12) [Cancel]
Click this to close the window without saving the box properties.

When “Send email when an error occurs” and “Send email when job is completed” are enabled, 
the following e-Filing operations are notified.
- Scan to e-Filing
- Copy to e-Filing
- Print to e-Filing
- Fax/Internet Fax Received Forward to e-Filing
- e-Filing to Print
- e-Filing to Email

An administrator can configure the e-Filing notification setting in the TopAccess Administration 
tab -> Maintenance -> Notification page.  For more information, refer to the TopAccess Guide.

Folder Properties
If you select a folder within the Documents frame and, then, select File and Properties, the 
Folder Properties window appears.

1) Location
This displays the directory where the folder is located.

2) Contains
This displays the number of files the folder contains.

3) Created
This displays the date and time the folder was created.
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4) Modified
This displays the date and time the folder was last modified.

5) [OK]
Click this to close the window.

Document Properties
If you select a document within the Documents frame and, then, select File and Properties, the 
Document Properties window appears.

1) Location
This displays the directory where the document is located.

2) Total Page(s)
This displays the number of pages the document contains.

3) Size
This displays the data size of the document.

4) Created
This displays the date and time the document was created.

5) Modified
This displays the date and time the document was last modified.

6) Last Accessed
This displays the date and time the document was last accessed by any user.

7) [OK]
Click this to close the window.
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Page Properties
You can display the page properties  by selecting a page in a document within the Documents 
frame, selecting the desired page within the Contents frame and, then, selecting File and Page 
Properties.  The message “Please select at least one item.” when you are not selecting a page 
in a document.
When you select this function, the Page Properties window appears.

1) Format
This displays how the page is stored.

2) Resolution
This displays the resolution of the page.

3) Image Size
This displays the pixel size of the page.

4) Paper Size
This displays the paper size of the page.

5) Size
This displays the data size of the page.

6) [OK]
Click this to close the window.
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Send Email

You can send selected documents as Emails from the e-Filing web utility.
When you perform this function, this equipment creates Email as attaching the selected docu-
ments as files and sends Email directly from the equipment.

To use the Send Email function, the Email configuration of the equipment needs to be set by the 
network administrator.

When you select this function, the Send Email page is displayed.

1) [To: Destination Setting]
Click this to specify the destination.  When you click this button, the Recipient List page 
appears.  For instructions on how to specify the destination, see the following section.

 P.101 “Destination Setting”
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2) [Cc: Destination Setting]
Click this to specify the Cc destination if required.

3) Subject
This sets the subject of the Email documents.  Select “Send from (Device Name) (Date) 
(Time)” to automatically apply the subject, or enter the desired subject in the field.

4) From Address
Enter the Email address of the sender.  When the recipient replies, the message will be sent 
to this Email address.

5) From Name
Enter the sender name of the Email document.

6) Body
Enter the body message of the Email document.  You can enter up to 1000 characters 
(including spaces).

7) File Format
Select the file format that the received document will be converted.

8) Encryption
Set this for encrypting PDF files if you have selected “PDF (Multi)” or “PDF (Single)” in the 
File Format setting.

9) File Name
Select how the attached file will be named.  Select “DocYYMMDD” to name as it described, 
select “Original Document Name” to use the original document name, or you can enter the 
desired file name in the field.

10)Fragment Message Size
Select the size of the message fragmentation.

11) Department Code
Enter the department code if required.

12) [Send]
Click this to send the e-Filing documents as Email.  This cannot be clicked when no destina-
tion is defined.

13) [Cancel]
Click this to cancel sending Email.

14) [Reset]
Click this to restore the default settings.
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Edit Menu Functions

You can find the Select All, Invert Selection, Cut, Copy, Paste and Delete functions under the 
Edit menu.

 P.221 “Select All”
 P.221 “Invert Selection”
 P.221 “Cut”
 P.221 “Copy”
 P.221 “Paste”
 P.222 “Delete”

Select All
This function checks the boxes of all documents or folders in the Contents frame.

Invert Selection
This function checks the boxes of all items that are not selected and unchecks the boxes of all 
items that are selected in the Contents frame.

Cut

This function is enabled when you select a document in the Documents frame and check one or 
more documents in the Contents frame. Also you can cut pages in a document.  To cut pages, 
enter the Edit mode.  When you cut items, they are removed from its current location in the 
folder structure and the system temporarily stores the items that you cut on the clipboard. The 
system removes items from temporary storage if you cut or copy another item or log off.
When you cut items, the Paste function is enabled. Cut and then Paste to move documents and 
pages.

Copy

This function is enabled when you select a document in the Documents frame and check one or 
more documents in the Contents frame. Also you can copy pages in a document.  When you 
copy items, the system temporarily stores the items that you copy on the clipboard. The system 
removes items from temporary storage if you cut or copy another item or log off.
When you copy items, the Paste function is enabled. Copy documents and then Paste to dupli-
cate documents in other location or merge into another document.

Paste

This function is enabled when you cut or copy documents pages and place them on the clip-
board. When you click Paste from the Edit menu, the system inserts the contents of the clip-
board at the current cursor position.
If you cut or copy a page, you can paste it into a document, or a box and folder to paste it as a 
document. If you cut or copy a document, you can paste it into a document, or a box and folder.
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Delete
This function is enabled when you select one or more items from the Contents frame. When you 
click Delete from the Edit menu, the system asks you for confirmation. Click OK to delete the 
selected item(s) or Cancel to abort the Delete function.
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View Menu Functions

You can choose among several options in which to display your documents or files. These 
options are Thumbnail, List, Beginning, Previous, Next, and End.

 P.223 “Thumbnail”
 P.224 “List”
 P.224 “Beginning”
 P.224 “Previous”
 P.224 “Next”
 P.224 “End”

Thumbnail
When you click Thumbnail, e-Filing web utility displays several small images of files or pages in 
the Contents frame. Files are represented by their first page. Each image is identified by its file-
name or page number. A check box below each image allows you to select it.
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List
When you click List, e-Filing web utility displays a table of file names and properties with check 
boxes in the Contents frame. This view is useful for managing folders that contain a large num-
ber of files.

Beginning

When you click Beginning, e-Filing web utility displays the first items in the Contents frame.

Previous

When you click Previous, e-Filing web utility displays the previous set of items in the Contents 
frame.

Next

When you click Next, e-Filing web utility displays the items that immediately follow those dis-
played in the Content frame.

End

When you click End, e-Filing web utility displays the last items in the Contents frame.
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Layout Menu Functions

To changes to the appearance of your document, go to the Layout menu.
 P.225 “Insert Blank Page”

Insert Blank Page
You can insert blank pages into your document, if you need to format the document for printing.
When you select the Insert Blank Page function from the Layout menu, the Insert Blank Page 
window will appear.

* Please note that the window may be slightly different depending on the system you are using.

1) Paper Size
The list at the left in the window shows the available paper size that can be inserted as a 
blank page.  Select the paper size of the blank page to be inserted.

2) Orientation
The list at the right in the window shows the orientation.  Select the orientation of the blank 
page to be inserted.

3) [OK]
Click this to insert the blank page.

4) [Cancel]
Click this to cancel inserting the blank page and close the window.
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7.Troubleshooting

This section describes about troubleshooting for e-Filing features.
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Troubleshooting for e-Filing Web Utility

Limitations and Considerations
When you edit or delete a document that is shared by other users, make sure to refresh the 
display to see the current status of the document.  If several users edit or delete the docu-
ment and pages at the same time, data may be damaged.
Do not perform any operations on the main window during the child window is opened.  The 
operations may not work properly.
Do not close the child window from the [X] button of the window.  The operations may not 
work properly.
When numerous child windows appear, close all windows to exit e-Filing and delete all cook-
ies from the Internet Options (for Internet Explorer) or Preferences (for Netscape Navigator).
It will take a long time to display the Contents frame that includes more than 100 boxes, fold-
ers, and documents.
More than 2 GB data cannot be archived.
The box password cannot be changed if any users access the box that you want to change 
the password.
If you click other system tabs or the login link during any operations have been processed, 
the e-Filing web utility will finish the session and close the e-Filing main window.
If you click browser’s [Back], [Update], or [Home] button during any operations have been 
processed, the e-Filing web utility will finish the session and close the e-Filing main window.
Do not perform any operations while displaying the contents or processing a operation.

Error Messages
When any error message is displayed, find the error message from the table below and trouble-
shoot the problem.

Message Corrective Action

Internal error occurred. Please restart e-Fil-
ing.

Turn OFF and ON the power of the equipment 
and then try again.  If the error message is still 
displayed, contact your system administrator 
or contact your dealer for support.

Your e-Filing Session has Timed Out. Please 
Restart.

Exit e-Filing and change the session timer 
setting to be longer in the Setup page of the 
TopAccess Administrator mode.  Then restart 
it.

The items have been modified. The items are currently modified by another 
user.  Try again after another user finishes 
modifying the items.

Cannot start e-Filing Session. The Disk is 
Full.

Erase the unnecessary data from the Control 
Panel. For instructions on how to delete data 
from the Control Panel, see Operator’s Man-
ual for Basic Functions.

Cannot create a Box.The Disk is full. Erase the unnecessary data using the admin-
istrative function or deleting the data in boxes 
for maintaining the hard disk space.

Cannot create a Folder.The Disk is full. Erase the unnecessary data using the admin-
istrative function or deleting the data in boxes 
for maintaining the hard disk space.

Cannot edit the Document.The Disk is full. Erase the unnecessary data using the admin-
istrative function or deleting the data in boxes 
for maintaining the hard disk space.
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Cannot insert Page.The Disk is full. Erase the unnecessary data using the admin-
istrative function or deleting the data in boxes 
for maintaining the hard disk space.

Cannot archive Documents.The Disk is full. Erase the unnecessary data using the admin-
istrative function or deleting the data in boxes 
for maintaining the hard disk space.

Cannot upload archived file.The Disk is full. Erase the unnecessary data using the admin-
istrative function or deleting the data in boxes 
for maintaining the hard disk space.

Cut failed. Disk is full. Erase the unnecessary data using the admin-
istrative function or deleting the data in boxes 
for maintaining the hard disk space.

Copy failed. Disk is full. Erase the unnecessary data using the admin-
istrative function or deleting the data in boxes 
for maintaining the hard disk space.

Paste failed. Disk is full. Erase the unnecessary data using the admin-
istrative function or deleting the data in boxes 
for maintaining the hard disk space.

Save failed. Disk is full. Erase the unnecessary data using the admin-
istrative function or deleting the data in boxes 
for maintaining the hard disk space.

Cannot create a Folder. Maximum number of 
folders has been reached.

Delete unnecessary folders and create a new 
folder.  You can create up to 100 folders in 
each box.

Cannot create a document. Maximum number 
of documents has been reached.

Delete unnecessary documents and create a 
new document.  You can create up to 400 
documents in each box and folder.

Cannot insert Page. Maximum number of 
pages has been reached.

Delete unnecessary pages and insert a new 
page.  A document can contain up to 200 
pages.

Paste failed. Maximum number of page range 
is reached.

Delete unnecessary pages and paste pages 
in the document.  A document can contain up 
to 200 pages.

Cut failed.The items have been deleted or 
modified.

Refresh the page and make sure the items 
was deleted or currently being modified.

Copy failed.The items have been deleted or 
modified.

Refresh the page and make sure the items 
was deleted or currently being modified.

Paste failed.The items have been deleted or 
modified.

Refresh the page and make sure the items 
was deleted or currently being modified.

Delete failed.The items have been deleted or 
modified.

Refresh the page and make sure the items 
was deleted or currently being modified.

Please enter valid password. Enter correct password.

A folder with the name you specified already 
exists. Please try again.

Use a name that does not exit in the box.

Another user has been archiving or upload-
ing.Please try again later.

The document is being archiving or uploading 
by another user.  Try again after another user 
finishes archiving or uploading.

Message Corrective Action
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The Maximum Possible Archive Size exceed. 
Archive is not Possible.

Archive is not possible if the archive size (ZIP 
file size) is more than 2GB. Archive the data 
separately so that the archive size will be less 
than 2GB.

The Box cannot be erased. A document con-
tained in Box is being used.  

A document contained in the box is being 
used by another user.  Try again after another 
user finishes using the document.

The document is being used. Please try again 
later.

The selected document is being used by 
another user.  Try again after another user fin-
ishes using the document.

File format doesn’t correspond. Please con-
tact Administrator.

Contact your administrator to convert the 
archive file and try again.

e-Filing is not ready. Please try again later. e-Filing has not been activated yet.  Try again 
later.

Message Corrective Action
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TWAIN and File Downloader Errors

This chapter describes the most common TWAIN and File Downloader errors and provides 
steps to resolve the conditions. If the problem persists after you have followed all of the steps, 
make sure to note the name of the application you were using, what you were trying to do, and 
any error messages — and then contact a authorized dealer for further assistance.

Please refer to the README file for TWAIN driver and File Downloader about the problems that 
are not described here.

TWAIN Driver and File Downloader Error Conditions
Refer to the corrective action for the following error conditions.

 P.231 “Cannot Find the Device”
 P.232 “Cannot Connect to the Device Found by Discovery”
 P.232 “Cannot Acquire Document”
 P.232 “Image Corrupt When Acquiring Color Mixed Document*”
 P.233 “Saved as Single Page TIFF Files Even Though You Select Multi Page TIFF Format”
 P.233 “Cannot Open TIFF File Saved Using File Downloader”
 P.233 “Cannot Change Resolution by Shrink To Half”
 P.233 “Cannot Acquire Multi page Document”

* Only applicable to the color model.

Cannot Find the Device

Problem Description:
Cannot find this equipment using the Local Discovery or Network Discovery feature.

Corrective Action:
Confirm the following statements:

The equipment and your computer is correctly connected to the TCP/IP network.
The default gateway setting is correctly set up if the equipment is connected to a different 
subnet.

The TWAIN Driver and File Downloader do not support the GL-1010 or GL-1020 controller.  
These devices cannot be found by the Discovery function.
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Cannot Connect to the Device Found by Discovery

Problem Description:
The Local Discovery finds the device, but you cannot connect to it.

Corrective Action:
1. Make sure Microsoft Internet Explorer 5.5 SP2 or later is installed when IPv4 is used. Make 

sure Microsoft Internet Explorer 7.0 or later is installed when IPv6 is used.
2. Make sure the Proxy settings on the Microsoft Internet Explorer have been set correctly so 

that it can connect to the device.
3. Make sure Microsoft Internet Explorer is not in the off-line mode.  If it is in off-line mode, 

change it to the on-line mode.

It also fails to connect to the device when too many computers connect to the device at the 
same time.  Please try again later.

Cannot Acquire Document

Problem Description:
Cannot acquire a document using the TWAIN Driver.

Corrective Action:
The TWAIN Driver is carefully tested with several TWAIN-compliant applications. However, 
some applications need settings to acquire a document from the device, and applications that 
have not been tested cannot connect to the device. See the readme file about the required set-
tings in applications that have been tested.  Also, you may be able to use an application that has 
not been tested by enabling the TWAIN Driver’s Native UI, or changing the Data Transfer Mode.  
For more details about TWAIN settings on your application, see the user manual for your appli-
cation.

Image Corrupt When Acquiring Color Mixed Document*

Problem Description:
Image will be corrupt when acquiring the document that contains both color pages and black and 
white pages, using the TWAIN driver.

Corrective Action:
Some applications do not support acquiring the color and black/white mixed document.  In that 
case, acquire the color pages and black and white pages separately, or save the document as a 
file using the File Downloader.
* Only applicable to the color model.
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Saved as Single Page TIFF Files Even Though You Select 
Multi Page TIFF Format

Problem Description:
Even thought you select to save the document as multi page TIFF format, the document was 
saved as single page TIFF files.

Corrective Action:
The File Downloader cannot save the color and black/white mixed document as a multi page 
TIFF file.  In that case, the File Downloader saves the black and white document as single page 
TIFF files, and color document as JPEG files.  If you want to save the document as one file, 
save it as a PDF file.

Cannot Open TIFF File Saved Using File Downloader

Problem Description:
Cannot open the TIFF file that has been saved using the File Downloader.

Corrective Action:
When you select TIFF format to save the color/grayscale document using the File Downloader,  
the document will be saved as TIFF file with JPEG compression.  If you open the file using an 
application that does not support the TIFF file with JPEG compression, it cannot be opened.  In 
that case, save the document as a JPEG file or PDF file.

Cannot Change Resolution by Shrink To Half

Problem Description:
Even though you enable the Shrink to Half function, the resolution of an image that was acquired 
is not changed.

Corrective Action:
The Shrink to Half function is available only for 600x600dpi documents that are stored in e-Filing 
by copy and print operations.  This function cannot reduce the resolution of an image that is 
stored by scan and fax operation.  If you want to change the resolution of the image, change the 
resolution after opening the file using an application.

Cannot Acquire Multi page Document

Problem Description:
Cannot acquire a multipage document from an application.

Corrective Action:
Some applications do not support multi page scan from TWAIN I/F, or need to be configured to 
acquire multi page documents. See the user documentation of an application that you use.
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